Cityworks® and ArcGIS® empower GIS for municipalities and public utilities who demand flexible technology solutions to manage asset infrastructure and location data.

Whether you require a cloud-based or on-premises solution, Cityworks provides the most effective applications for any level of government to improve operational insights and customer service. No matter how complicated your process or infrastructure, we have scalable solutions to meet your expanding needs. Prioritize risk, improve operations, support business processes, and manage work more effectively.

Discover how Cityworks can help you create flexible solutions and revolutionize how you manage your organization.
Focus

12 The Evolution of Smart Communities
16 Digital Twin Helps Airport Optimize Operations

Special Section

30 Finding the Perfect Spot
Pennsylvania Plants Trees Precisely with GIS
36 Identifying the Most Valuable Parcels to Protect

End Notes

66 He Pays Attention to the Little Things That Run the World
68 The Half-Earth(ling)

On the Cover
Amsterdam Airport Schiphol built a digital asset twin of the airport so that it can run simulations on potential operational failures throughout the entire complex, which saves both time and money.
As Esri president Jack Dangermond often observes, “Geography is the science of our world.” In the 50 years since its founding, Esri has developed GIS into the location technology that uses geography to see relationships, interdependencies, and patterns in the complexity of the Earth at scales from the local to the global. This perspective reveals innovative solutions and informs decision-making to better deal with the challenges the world faces.

That technology has enormously expanded from mapping software to encompass a plethora of tools for analysis and visualization, models, data integration capabilities, and data services that are available from the Esri Geospatial Cloud and ArcGIS Enterprise in apps, solutions, and desktop software.

Articles in this issue illustrate how Esri and its location technology enable action around the world at all levels.

On the local level, the Smart Community Information System approach is fostering truly smart communities that are more efficient, livable, and sustainable.

On a regional level, Esri technology is supporting strategies for preserving water, soil, and wildlife habitat and identifying land that must be protected.

On the national level, an nongovernmental organization is using ArcGIS for promoting best practices in the agricultural sector, which is so critical to the well-being and economic development of the people in Ghana.

On the global level, Esri is supporting the E.O. Wilson Biodiversity Foundation’s Half-Earth Project by helping map the world’s known species as part of an effort to preserve the Earth’s biodiversity through a system of natural reserves.

Esri, originally as a collaborator, and now as an associate member of the Group on Earth Observations (GEO) has been working on GEO initiatives. Together Esri and project lead US Geological Survey (USGS) have devised a methodology to map global ecosystems that has so far produced the global Ecological Land Units (ELU) and Ecological Marine Units (EMU).

These articles also show how a spatial perspective enabled by location technology can be transformative. Instead of evaluating projects or programs on criteria that is narrowly defined by a discipline, such as engineering or planning, a geographic approach employs a more holistic and visual approach that encourages the collaboration and consensus that leads to intelligent action.

Monica Pratt
ArcUser Editor
OVER 15 DAYS in November 2018, the Woolsey Fire burned almost 97,000 acres in California, damaging or destroying thousands of structures in Los Angeles and Ventura Counties. The United Services Automobile Association (USAA) needed to identify damaged and undamaged buildings in the area to process the claims of its customers as quickly as possible.

In the aftermath of a natural disaster, response and recovery efforts can be drastically slowed down by manual data collection. Traditionally, insurance assessors and government officials must rely on human interpretation of imagery and site visits to assess damage and loss. Depending on the scope of a disaster, this process can significantly delay relief to disaster victims.

USAA used the deep learning capabilities of ArcGIS to quickly identify damaged structures within the fire perimeter. This information allowed insurance adjusters to fast-track the claims of affected residents and businesses. The process of capturing training samples, training the deep learning model, running inference (categorization) tools, and detecting damaged homes was accomplished entirely within the ArcGIS platform.

MANAGING IMAGERY
Before the fires were extinguished, DataWing Global, an end-to-end aerial data services company, flew drones within the fire perimeter and captured high-resolution imagery of impacted areas. The imagery, totaling 40 GB in size, was managed using a mosaic dataset, the primary method for managing large volumes of imagery in ArcGIS.

LABELING AND PREPARING TRAINING SAMPLES
Prior to training a deep learning model, training samples must be created that represent areas of interest. Building footprint data was obtained from the Los Angeles County GIS Data Portal. Building footprints were overlaid on the high-resolution drone imagery in ArcGIS Pro. A new field called ClassValue was added to the building footprint feature class to contain the results of manually labeling several hundred homes as damaged or undamaged.

These categorized features were exported training samples using the Export Training Data For Deep Learning tool in ArcGIS Pro. The metadata output format was set to Labeled Tiles. The Labeled Tiles were used for training the Damage Classification model.
SOFTWARE AND DATA

TRAINING THE DEEP LEARNING MODEL

ArcGIS Notebooks was used for training purposes. [ArcGIS Notebooks provides users with a Jupyter Notebook environment that is hosted in ArcGIS Enterprise portal and powered by ArcGIS Notebook Server.] Because ArcGIS Notebooks is preconfigured with the necessary deep learning libraries, no extra setup was required. With a few lines of code, the training samples exported from ArcGIS Pro were augmented.

Using the arcgis.learn module in the ArcGIS API for Python, optimum training parameters for the damage assessment model were set. The deep learning model was trained using a ResNet34 architecture to classify all buildings in the imagery as either damaged or undamaged.

After ArcGIS Notebooks finished running, ground truth labels (the manually assigned labels) were compared to the model classification results to assess how well the model performed. Training the model using a ResNet34 architecture gave an accuracy rate greater than 99 percent. For complete details on the training process, see the post “Building Footprint Extraction and Damage Classification” (https://bit.ly/33R00Zx) on Medium.

RUNNING INFEERENCETOOLS

With the model.save() function, the model can be saved and used for inferencing purposes. Inferencing was performed using the ArcGIS API for Python. By running inferencing inside ArcGIS Enterprise using the model and classify_features function in Notebooks,
inference can be performed at scale.

The result is a feature service that can be viewed in ArcGIS Pro. More than 9,000 buildings were automatically classified using deep learning capabilities in ArcGIS. The map resulting from this analysis showed damaged buildings marked in red and undamaged buildings marked in green. With 99 percent accuracy, the model is approaching the performance of a trained adjuster. What used to take days or weeks, can now be done in just hours.

**UNDERSTANDING WHO WAS AFFECTED**

The value of deep learning goes beyond helping USAA respond more quickly to the needs of its customers. Once damaged houses and businesses were identified, ArcGIS could be used to gain a better understanding of the people affected by the fire. When deploying response units to disaster areas, it’s important to know where at-risk populations, such as the elderly or children, are located. Generating infographics using ArcGIS Business Analyst lets responders easily see the characteristics of impacted communities. A report summarizing this information can help agencies responding to a disaster make more informed decisions more rapidly.

Using Operations Dashboard for ArcGIS, the results of analysis combined with enriched feature layers let incident managers and others coordinating response dynamically access the status of any structure and the value of the damaged structures to better serve the needs of affected populations.

**IMPROVING RESPONSE AND RECOVERY**

Using the deep learning, imagery, and data enrichment capabilities in the ArcGIS platform can improve damage assessment to speed insurance claims processing and support rapid response and recovery activities.

**ABOUT THE AUTHORS**

Vinay Viswambharan is a product manager at Esri whose work focuses on everything about imagery in the ArcGIS platform. He is passionate about remote sensing and image analysis and has more than 20 years of experience in the geospatial industry. He has built products that work with spatial information; designed and built products that analyze, visualize, and explore imagery; and integrated imagery and spatial data in products that increase the value of GIS and remote sensing technology in various industries.

Rohit Singh is the managing director of Esri’s R&D Center in New Delhi and leads the development of data science, deep learning, and geospatial AI solutions in the ArcGIS platform. He is passionate about deep learning and its intersection with geospatial data and satellite imagery. He conceptualized, designed, and developed the ArcGIS API for Python, ArcObjects Java, ArcGIS Engine Java API, and ArcGIS Enterprise (Linux) while at Esri. He has been recognized as an Industry Distinguished Lecturer for the IEEE—Geoscience and Remote Sensing Society (GRSS). A graduate of the Indian Institute of Technology, Kharagpur, Singh worked at computer vision startups and IBM before joining Esri.

**ADDITIONAL RESOURCES**

- Distributed Processing with Raster Analytics  https://bit.ly/2ZenHex
Esri Selected as GEO Associate Member

The Group on Earth Observations (GEO), an intergovernmental organization that works toward advancing open data and promoting sustainability via Earth observations, has chosen Esri as one of seven organizations to join as its first associate members. The new GEO Associates category allows commercial and nongovernmental entities to join existing member institutions in activities promoting GEO’s goals and ideals.

Esri’s associate member status acknowledges its seven years of involvement with GEO and Esri’s commitment to continue collaborating on GEO initiatives and developing interoperability between the Global Earth Observation System of Systems (GEOSS) and ArcGIS platform to promote data access between GEO collaborators and Esri users.

“We are honored to be chosen as one of the first members in GEO’s new member category,” said Jack Dangermond, Esri founder and president. “GEO is doing incredibly important work in improving critical decision-making in areas like sustainable development goals, disaster recovery, and natural resource management, as well as making Earth observation data accessible to everyone.”

The following are some of the activities associated with GEO initiatives Esri has supported.

Image Data Cube Accessibility

Esri, in collaboration with NASA, Committee on Earth Observation Satellites (CEOS), and Geoscience Australia has developed an efficient software solution that enables Esri software users to easily access a variety of image data cube styles, publish web services, and use the data for visualization and analysis. As part of this effort, Esri is publishing Digital Earth Africa image services and web applications as part of the Africa GeoPortal (africageoportal.com).

Global Ecosystem Modeling

In response to GEO’s desire for foundational ecological data to enable ecosystem management, Esri partnered with project lead US Geological Survey (USGS) to devise a methodology to map ecosystems. Esri has been supporting this effort with in-kind resources for data compilation, modeling, and web app development.

This initiative to develop globally consistent, statistically based ecosystem classifications began in 2013. The global Ecological Land Units (ELU) were completed in 2014. Following this was Ecological Marine Units (EMU) in 2017. This partnership is currently developing the Ecological Coastal Units (ECU).

In addition to helping develop these valuable data resources and web services, Esri has built user friendly applications, such as the Ecological Marine Unit Explorer apps, to promote and socialize the data and make the data more easily accessible and usable.

Global Stream Flow Forecasting

Esri has been collaborating with Brigham Young University, European Centre for Medium-Range Weather Forecasts (ECMWF), and other partners as part of the GEO Global Water Sustainability initiative. The initiative is extending the value of the ECMWF grid-ded global runoff model by downscaling the information onto the river network. It is publishing open web services of forecasted and historic stream flow and an interactive web application for exploring modeled future and historic stream flow. These efforts are improving disaster preparedness and sustainable use.

Portal Integration and Local Training

Esri and its network of global distributors and partners have also been engaged in collaborations for improving access to the GEOSS and AmeriGEOSS portals and providing in-country training on using ArcGIS open data publishing and integration with the systems and services codeveloped through GEO initiatives.

These collaborations demonstrate Esri’s commitment to making open data as web services, the importance of scalable cloud-based image data management and big data analytics, and the role of easy-to-use web applications in expanding the impact of earth observation data to inform decision-making.
Briefly Noted

→ The 20th GIS Day Is Almost Here

GIS Day is not just an event. It’s a global movement. This celebration brings universities, government agencies, schools, non-profits, and GIS professionals together to share knowledge of GIS with their communities and create understanding about the world. Members of the GIS community show colleagues, students, and the public how and why to use geospatial technology. November 13, 2019 marks the 20th anniversary of GIS Day. Find or register an event at gisday.com and celebrate.

→ Live Feeds Weather Data Provided as Feature Services

Real-time weather maps and layers, available to the public from the ArcGIS Living Atlas of the World, are hosted as feature services and no longer require subscriptions.

For many years, Esri has been making a wealth of real-time weather information available through the ArcGIS Living Atlas of the World. Weather data for the US and the world is based on official data generated by the National Weather Service, NASA, US Geological Survey, and other authoritative sources. Esri has been evolving its weather and disaster services to meet the ever-increasing demand for them by leveraging its continually improving technology.

The new, real-time weather maps and layers offer key improvements over the layers they replace which used older map service technology. The new services autoscale within the Microsoft Azure cloud architecture to meet high-demand events, such as a hurricane making landfall. They will update displays automatically in the browser without any interaction to override a cached display.

Improvements in hosted feature layer technology let users create unique displays and pop-ups from attributes across different layers using FeatureSets, a new set of ArcGIS Arcade data functions. With FeatureSets, multiple features in a layer can be used when authoring a pop-up or calculating fields.

Live feeds of weather and disaster data can be used to create a variety of maps and analyses in the ArcGIS platform. The new feature services are more closely integrated with the ArcGIS platform to work more seamlessly with ArcGIS Pro, ArcGIS Online, ArcGIS Insights, and Operations Dashboard for ArcGIS.

The older map service weather live feeds will continue for a year to allow users to transition before the map services are deprecated. Esri will release improved versions of live feed services, including Recent Earthquakes, USA Fire Activity, USA Drought Intensity, and some completely new offerings. Making these services as free and open data continues Esri’s commitment to supporting emergency management and disaster preparedness around the world.
Data Capture on the Move

Use ArcGIS QuickCapture to support your at-speed field data collection workflows. ArcGIS QuickCapture was created specifically for field teams performing aerial surveys, monitoring vegetation encroachment, inventorying asset inventories, making road inspections, carrying out windshield surveys, and other inspections at-quickly in the field. With its minimalistic big button user experience, the QuickCapture mobile app is the easiest and quickest way to capture georeferenced field observations, even while on the move. The QuickCapture mobile app is included with the Field Worker user type, and it is also available as an add-on license on top of the Editor user type. To get started, check Quick Capture tutorials, and join the community at GeoNet at http://bit.ly/geonetquickcapture.

Feature Reports for Survey123 for ArcGIS

Generate high-quality printable documents from data captured in a single Survey123 for ArcGIS record using Survey123 Feature Reports, an ArcGIS Online Premium service. Simply define the contents and report design in Microsoft Word and associate the report template with the survey by using keywords that reference questions in your survey.

Survey123 Feature Reports service is useful for presenting data using strict formatting guidelines to mimic legacy paper forms or comply with the format for legal documents. For example, use Survey123 Feature Reports for documenting inspections or generating citations for city code violations. Reports can be generated in bulk or automated using Survey123 webhook support so a Feature Report document is created and emailed as soon as a survey record is added to ArcGIS. Build conditional logic to incorporate or hide certain portions of a survey record. Add repeatable sections to loop through related records and extract data from attachments for display in a report.

However, the concept of smart has been evolving. Esri is refocusing the conversation around smart from vague promises to a specific geospatial strategy that can deliver the results communities seek. Smart, in the context of government, is associated with the use of real-time data, 3D visualization, the application of artificial intelligence for automation and optimization, and other technologies being enlisted to improve the lives of citizens. These technologies provide new ways to deal with challenges such as failing infrastructure, increasing demands on government services, threats to the environment, and the need for social equity.

By looking at communities that had truly become smart, patterns of adoption became apparent. Successful communities have a strategy that is connected to the operational goals that enhance sustainability, resilience, livability, health, safety, and prosperity. The use of smart strategies began in communities but is increasingly adopted at county and state levels.

Recognizing that implementing a smart strategy requires both data and technology, Esri has developed a Smart Community Information System that encourages an integrated approach so communities can identify priorities, improve processes, and achieve organizational goals.

Why Smart Is Spatial
In government, location is never an afterthought. Where is what connects people around a project and provides context. Location plays a critical role in everything government does, from long-range planning to asset management, from public safety response to addressing citizen requests. Smart devices, the Internet of Things (IoT), and cloud computing feed data on the locations of people, nature, vehicles, and infrastructure. The complex data needed for government’s myriad missions is brought together by GIS so that it is easier to understand, analyze, and act on. Smart communities thrive when location is at the forefront of operations.

“We look at everything through the lens of geography,” said Chris Thomas, director of government marketing at Esri. “Everything we do requires a focal point, which is where people live, work, and play. This is why GIS is recognized as a foundational part of every smart strategy.”
Supporting Smart
Geospatial information is the foundation for building a Smart Community Information System and GIS is the technology for implementing it. Smart Community Information Systems are organized around four technology tenets:
1. Planning and Engineering
2. Operational Efficiency
3. Data-Driven Performance
4. Civic Inclusion
   These systems encompass data and solutions and require implementation, training, and partners.

1 Planning and Engineering

Smart communities must balance the often competing demands of built and natural environments with the additional challenges of economic stress and climate change. In implementing smart communities, the focus on planning and engineering is not limited to the work traditionally done by municipal departments with those names but more broadly refers to meeting community needs through urban design that is human centered to produce resilient and sustainable communities. By incorporating 3D visualizations, benchmarks, and analysis, communities can balance the needs of people, infrastructure, and the environment by modeling the impacts of proposed development, adjusting plans to accommodate changing demographics and lifestyles, and accounting for the effects of climate change and economic shifts.

Seeing the Future: City of Oshkosh, Wisconsin
The City of Oshkosh, located on the shores of Lake Winnebago in northeast Wisconsin, was founded in the 1800s as a center for lumber and other industries. As these industries declined in recent years, taking jobs away and leaving behind dilapidated and vacant buildings, the city realized it needed a plan for reinvigorating the local economy.

It responded with Imagine Oshkosh, a 10-year strategy for promoting growth and investment in the greater downtown area. This strategy relies on GIS to plan and visualize a vibrant and prosperous future. Esri Community Analyst and Esri Business Analyst provided a deeper understanding of Oshkosh’s demographics and economic strengths that could be shared with developers and other investors.

For example, a developer hoping to attract a minor league baseball team to the city turned to Esri partner Houseal Lavigne Associates, which used Esri CityEngine to create a 3D visualization of the proposed entertainment district along the waterfront that would house offices, retail, multifamily homes, and an arena for the team. The Milwaukee Bucks could see the city’s potential and were sold on the project. City residents, who could see Imagine Oshkosh’s vision, thanks to 3D visualization, were enthusiastic supporters of the project.

2 Operational Efficiency

Operational efficiency is just good government. GIS supports a broad range of technologies—from field mobility to the use of virtual assistants for open data access—that promote operational efficiency. GIS collects information in real time and feeds it back into the system, where it can be displayed and analyzed by dashboards. Making more efficient use of resources reduces the cost of government.

Improved workflows also support more responsive services by intelligently allocating resources where they are most beneficial. A GIS-based Smart Community Information System collects data in real time, performs analysis, and makes the resultant information available as the basis for better decisions through performance dashboards. More efficient workflows come from collecting data directly in the field and making it centrally available so it can be acted on immediately, thus eliminating inefficient and potentially error-prone paper capture and manual updates. Streamlining processes saves time, maximizes resources, and improves response times.

By using dashboards, story maps, and web apps, the information produced can be shared with government staff and constituents in ways that are easy to understand, widely accessible, and convenient.
Optimizing Coordination and Decisions for the Rose Parade

Each year, hundreds of thousands of people line Colorado Boulevard in Pasadena, California, to view the Pasadena Tournament of Roses, a parade billed as “America’s New Year Celebration,” as another 76 million around the world watch the event on television. Departments across the City of Pasadena and planning committees work together to coordinate the event and ensure the well-being of spectators and the hundreds of people participating in the parade. In the decades since the parade debuted in 1890, its success and the safety of the fragile floral floats that are the event’s centerpiece have been threatened by rain, high winds, and wildfires.

“In the past, we’ve only had information in paper format,” said Oscar Sepulveda III, captain-paramedic with the City of Pasadena Fire Department. The city moved to a GIS-based strategy that uses mobile devices and dashboards. The Pasadena Fire Department uses Tracker for ArcGIS to capture real-time data about parade floats, fire department assets, and medical incidents. Live maps are easily shared with multiple fire chiefs, the Federal Bureau of Investigation, the Department of Homeland Security, and officers working at the event. These maps improve coordination across various agencies and response to potential hazards.

“For the past four years, we’ve been working on utilizing technology to give us the up-to-date information that we need to make decisions that are going to impact safety,” said Pasadena fire chief Bertral Washington.

Cobb County models traffic flows in 3D.
County traffic managers monitor conditions using dashboards with real-time road closure, traffic accident, vehicle, and pedestrian data feeds. They adjust flows as necessary.

Linking data with location to improve decisions using GIS is nothing new. In 2000, Martin O’Malley, then mayor of Baltimore, Maryland, used a GIS-based tool called CitiStat that brought performance management and accountability to the city and reduced waste and inefficiency in government operations.

The difference now is the great increase in the amount of data that can be analyzed, incorporated, and communicated and the great decrease in the time required to do this using GIS. With the Smart Community Information System, real-time data harvested from mobile devices and device sensors connected through the IoT is analyzed using an ever-growing toolset that includes artificial intelligence capabilities and rapidly shared with decision-makers using dashboards and other visualization tools.

Esri is uniquely able to support government decisions driven by data and analytics because it is also a demographic and lifestyle company. It provides current-year estimates and five-year...
projections of demographic data with 2,000 variables; Tapestry market segmentation; and data on consumer spending, market potential, business locations, major shopping centers, traffic counts, crime indexes, United States Census, and American Community Survey.

With GIS, current and historical data, from many sources and in many formats, can be analyzed at a rate that enables more rapid decision-making and increases the pace of government services.

Using Real-Time Data to Improve Traffic
Instead of relying on historic traffic data to time its traffic signals, Cobb County, Georgia, is improving transportation management across the community by modifying traffic patterns in real time. The county has incorporated GIS into its Sydney Coordinated Adaptive Traffic System (SCATS) and can manage the flows of both automotive and pedestrian traffic by changing traffic signals. The system incorporates the variables that cause congestion and applies artificial intelligence to optimize system coordination. Real-time road closure, traffic accident, vehicle, and pedestrian data is fed to an operations dashboard monitored by traffic managers who adjust traffic flows as necessary.

4 Civic Inclusion

Smart communities use technology to improve the lives of citizens. Citizens now expect government that is responsive, convenient, and transparent. Because people care about where they live, citizens want to work with government to meet community needs and challenges and shape their future. By using story maps and ArcGIS Hub sites on topics that range from capital improvement projects to the opioid overdose epidemic, GIS enables smart communities to more effectively communicate with citizens and enlist their participation. With tools such as ArcGIS Insights, governments can analyze data on demographics and behavior to inform policies so services reach the people that most need them.

Mitigating the Burden of Homelessness
The San Bernardino County Sheriff’s Department’s Homeless Outreach and Proactive Enforcement (H.O.P.E.) program links homeless people with the resources they need to transition from life on the street and reduces the costs associated with crime and blight related to homelessness. The program’s goal is to improve the quality of life for all citizens in the Southern California county.

By using solutions that are configurations of mobile apps, such as Survey123 for ArcGIS and Collector for ArcGIS, with Operations Dashboard for ArcGIS, deputies document and share information on homeless persons and track the location of their camps. This GIS-based strategy provides an overview of contact with homeless people and the location of camps.

In San Bernardino County, deputy sheriffs use ArcGIS solutions to document and share information on homeless persons.

This GIS-based strategy provides an overview of contact with homeless people and the location of camps.

Smart Is a Process
GIS is fundamental for building smart communities. Smart communities don’t result from one app or one project. They are the result of an iterative process that builds on successes and learns from failures, with the goal of a more responsive, effective, and inclusive community in mind. Consequently, a smart community will change over time. Smart is a journey enabled by GIS.
DIGITAL TWIN HELPS AIRPORT OPTIMIZE OPERATIONS

By Jim Baumann, Esri Writer
THE WORLD’S 11TH BUSIEST airport, the second largest in terms of hub connectivity, and the main international airport of the Netherlands, Amsterdam Airport Schiphol facilitates the movement of passengers and cargo throughout the Netherlands and the rest of Europe.

The airport originally implemented GIS in 1985. Currently, ArcGIS Enterprise is a core technology in its business processes. In 2017, Schiphol Airport began a capital improvement program, scheduled to last for several years, that involves a major renovation of existing facilities and the construction of new ones. To take advantage of the numerous digital assets created for the capital improvement program, Schiphol Airport built a digital asset twin of the airport. [See the accompanying article, “Digital Twins Enable Innovation and Savings”]

“The airport’s digital asset twin provides the opportunity to run simulations on potential operational failures throughout the entire complex, which saves us both time and money,” according to Kees van ’t Hoog, head of the Development Operations team at Schiphol Airport.
Schiphol’s contractors provide construction data in Industry Foundation Classes (IFC) format, a platform-neutral, open file format for standardizing data that is used for BIM. Every detail of a building—geometric and nongeometric design elements as well as construction information—is captured in the BIM. This information-rich model is used for analyzing design options and creating visualizations.

BIM data is processed using the ArcGIS Data Interoperability extension, which is an integrated spatial ETL (extract, transform, and load) toolset that runs within the geoprocessing framework of Safe Software’s FME technology. Through this processing, the BIM data is converted to scene layers that are able to be viewed with the ArcGIS API for JavaScript. Web scene layers are cached web layers optimized for displaying large volumes of 3D data in a browser.

The 3D Schiphol Urban View is a web scene, generated through this process, that gives managers, technicians, contractors, and other stakeholders a detailed view of the current status of construction. The web scene also functions as a dashboard for the asset management process. As part of Schiphol’s CDE, it can use attribute data from other systems and display real time asset data. In the future, Schiphol’s Development Operations team would like to create historic and planned construction views so that stakeholders can see the airport’s entire development process.

The facility incorporates smart components, capable of interacting with one another and reporting operational status in real-time so that a change in one component can affect and be detected by other components. Automated passenger and freight systems at the airport, such as escalators, conveyor belts, and ticketing machines, are monitored by an asset control signaling and monitoring (ACSM) implementation within Schiphol’s supervisory control and

This digital twin, known as the Common Data Environment (CDE), organizes data from many sources: building information model (BIM) data; GIS data; and data collected in real time on project changes and incidents as well as financial information, documents, and project portfolios.

CDE collects and processes data from remote sensors at the airport that are used in predictive maintenance. Within the 7,000-acre complex, the airport tracks and maintains more than 80,000 assets—both indoor and outdoor—from networks, runways, and lighting systems to information booths and fire extinguishers.
data acquisition (SCADA) system. Together, these systems continuously check the status of the multitude of servomotors, circuit boards, and mechanical devices that comprise these systems, while maintaining their maintenance history and monitoring the systems’ programmable logic controllers. Schiphol also uses IBM Maximo asset management software for asset registration and maintenance.

“The ACSM lets us monitor and manage all of the assets comprising these systems in real time from a dashboard,” said van ’t Hoog. “So if one of the components that make up these systems, such as a belt or motor, is not running correctly, we can turn the equipment off, automatically produce a work order, and assign a maintenance crew to immediately repair it.”

Schiphol has introduced Veovo’s BlipTrack technology as its indoor traffic monitoring system. BlipTrack sensors detect a passenger’s wireless device, and its unique ID is time-stamped and encrypted. As the device passes by multiple sensors, the system measures travel times and movement patterns. It provides both real-time and historic information about queue times, occupancy numbers, and flow patterns to airport management, which helps maintain a safe and secure environment.

“As the digital twin of Schiphol Airport continues to develop, we look forward to making greater use of (ArcGIS) GeoEvent Server to analyze our streaming sensor data,” concluded van ’t Hoog. “For example, because it is designed to process and analyze large datasets in real time, it could be very beneficial in enhancing our bird control application.”

ABOUT THE AUTHOR
Jim Baumann is a longtime employee at Esri. He has written articles on GIS technology and the computer graphics industry for more than 30 years.

MORE THAN JUST A VISUALIZATION, a digital twin can accelerate innovation, build consensus, and save time and money by iteratively modeling changes, testing how components or systems function, and troubleshooting malfunctions inexpensively in a virtual world.

A digital twin is a virtual representation of an object, process, or system that bridges the gap between the physical and digital worlds. It links the smart device sensors of physical components that gather real-time data on the working condition, position, or other characteristics of physical items with the virtual representations of those items in the digital twin.

By connecting components to a cloud-based system that processes the data gathered, the performance of entities in the physical world can be used in analyzing the performance of virtual models. Digital twins generate efficiencies by optimizing operations and workflows and proactively improving asset management by working with virtual objects and systems.

The concept of a digital twin is not new, but the ability to effectively implement it is. Michael Grieves introduced it in his 2002 white paper Digital Twin: Manufacturing Excellence through Virtual Factory Replication. Grieves posited the use of computer-aided design for developing digital objects, creating virtual factories to produce them, and running simulations to test plant operations.

Recently, the effects of continually increasing computational capabilities and the advent of the Internet of Things (IoT) have closed the gap between the promise of the digital twin and its reality. Although originally pioneered to improve the operations of manufacturing plants, the use of digital twins has been expanded to applications such as supply chains, wind farms, and even cities.

With its 3D and spatial analysis capabilities and the evolving integration of technologies such as building information model (BIM), augmented reality (AR), and virtual reality (VR), GIS offers tremendous benefits for modeling impacts and improving operations through the use of digital twins by government and industry for activities such as:

- Viewshed delineation
- Solar radiation assessment
- Shadow modeling
- Urban analytics
- Modeling sea level rise
- Space-time analysis

Creating a feedback loop between the design and production and between the virtual and real worlds yields substantial savings in time and money and a better understanding of processes and impacts.
We live in a data-crowded world. In his book Information Anxiety, Richard Saul Wurman has claimed that “A weekday edition of the New York Times contains more information than the average person was likely to come across in a lifetime in 17th-century England.” A quick check of the hard drive on my work computer shows that I have about 100 gigabytes of my own data. I’m not sure what all of it is or how many files are duplicates and junk, but that’s what the Properties tab says. We have access to terabytes and petabytes of data to do our work.

What to do with all this data? Plowing through it can take an inordinate amount of time. How do we make balanced, data-based decisions quickly?

One thing can help us: Location. It is commonly held that 80–90 percent of data has a geographic component or location. We often think of innovation as a new gadget, tool, or application, but innovation comes in many forms. There is incredible value in innovating with new thinking, analysis, and visualization using existing GIS tools that you may have overlooked.

Powered by services and easy to configure, Operations Dashboard for ArcGIS is an often underutilized GIS tool. Dashboards gather and distill data quickly into charts, graphs, and maps that enable rapid visualization and analysis of disparate data and deliver information at a glance. Emergency responders use dashboards extensively to combine data from different organizations.
Let’s Innovate.

Let’s look at our data in different ways using GIS tools that help us make better decisions faster. With GIS, we can quickly see what our data is trying to tell us.

We can See What Others Can’t.

About the Author
Brent Jones oversees Esri’s worldwide strategic planning, business development, and marketing activities for land records, cadastre, surveying, and land administration. As a recognized innovator, Jones specializes in modernizing existing land administration systems and designing new GIS-based cadastral management systems for small and large governments globally. He is a past member of the URISA board of directors, past president of the Geospatial Information and Technology Association, and a current member of the United Nations Committee of Experts on Geospatial Information Management, sitting on the Expert Group on Land Administration and Management.

Managers in real time and inform their decisions. Not only can dashboards help make rapid decisions, they can also add new information for more complex decisions and monitor ongoing work in your organization. In either case, dashboards let you react more intelligently to changing circumstances.

ArcGIS Insights delivers more in-depth analysis, leveraging your spatial data and enterprise data in one app. You can study your data visually and use location, maps, and analytics with near limitless ways to extract information from your data. For example, maybe you want to understand the change of cost per square foot of property based on its distance from a city park. Also powered by services, Insights is easily configured to meet specific analytical and visualization requirements to uncover trends, patterns, data issues, outliers and much more. Insights—along with Operations Dashboard—incorporates the analytical capabilities of ArcGIS.

We’re swimming in a sea of data. Most of that data has a location or geographic element that often goes unused. We’re not all GIS experts, but because both Operations Dashboard and Insights are designed for the non-GIS user, these tools can unlock the information in data by leveraging analytics and visualization that deliver new insights and produce better decisions, enabling smarter communities. Giving managers and many others in your organization access to these powerful tools enables innovation. Successful organizations are known for innovation in its many forms.

Share Your Story in ArcUser

Write an article for ArcUser magazine. Tell the GIS world how your organization saved money and time or acquired new capabilities using GIS. Share your GIS management insights or your expertise in extending the GIS functionality of Esri software.

esri.com/ausubmission
An Easier, Quicker Route to Success

Want to apply GIS to meet organizational challenges and improve operations but find that workload pressures and limited staff make this difficult? Save yourself unnecessary effort and get proven results with ArcGIS Solutions.

This collection of free and fully supported templates that configure ArcGIS to perform specific tasks and optimize workflows will save you time. The templates solve common problems and implement workflows for a specific industry, so you can focus on the problems that are unique to your organization. Using templates will give you those quick wins that sell GIS to leadership and help align your organization’s GIS with its strategic business needs.

Because ArcGIS Solutions are supported by Esri, they are sustainable. Templates are updated to work with new software releases so you avoid being trapped by legacy technology. This also means you can contact Esri Technical Support with questions. Esri Professional Services can help you quickly configure and deploy solutions. Many of Esri’s partners offer complementary applications that extend solutions and can help with deployment.

Each template incorporates the maps, apps, and tools with the functionality needed to accomplish a specific workflow. ArcGIS Solutions address the specific needs of local government, state government, emergency management, defense, intelligence, business, gas, electricity, water, and telecommunications. For example, under Local Government solutions, the subcategory for law enforcement has Opioid Response Dashboard and Road Closures templates.

Each solution provides an explanation of how it is used, its requirements, and release notes, and some have a sample you can try out. Deployment can be simplified by using the ArcGIS Solutions Deployment tool, but manual deployment is documented for each solution as well.

The gallery of solutions makes it easy to locate the solutions you need. Communities have grown around ArcGIS Solutions for each industry. Links to the GeoNet group, any related blogs, videos, ArcGIS Ideas suggestions, GitHub repositories, or Twitter accounts can be accessed from the Community page of the ArcGIS Solutions website. Through these communities, you can leverage collective knowledge of best practices and industry expertise.

Visit solutions.arcgis.com/#get-started to see how ArcGIS Solutions can help you get more done without doing more.

↓ The Homeless Point-in-Time Counts is a configuration of Operations Dashboard for ArcGIS and Survey123 for ArcGIS for use by health and human services agencies to monitor volunteers conducting surveys of the homeless.

↓↓ Use the Road Closures solution to maintain an inventory of road closures and communicate closures and detours to travelers.
Although the Greek philosopher Heraclitus observed, “The only thing that is constant is change” thousands of years ago, he could as easily be speaking to the GIS managers of today.

When organizations deploy ArcGIS software and new geospatial capabilities to improve operations, GIS managers often must prepare impacted staff members so they can quickly adopt new technology-driven workflows. The success or failure of a project or initiative rests as much on social change within the organization as on the technology.

A new instructor-led course from Esri, Preparing for Change, is designed specifically for GIS managers and organizational leaders who are modernizing GIS-supported workflows, planning a new ArcGIS deployment, or expanding ArcGIS access outside the current user base. For organizations that are planning a technology change that will significantly impact existing workflows, this course is an opportunity to learn how to prepare their people to quickly embrace change, adopt new workflows, and deliver meaningful results.

Preparing for Change provides practical steps that organizations can take to plan a people-focused change management effort. This class will also benefit senior managers who want to increase the overall adoption rate of new geospatial capabilities and influencers and change agents who are involved in ArcGIS projects and user adoption initiatives.

Guided by Prosci-certified Esri change practitioners, attendees participate in activities from the first phase of the popular Prosci ADKAR model of change management that include:

- Documenting the strategic implications of ArcGIS adoption at all levels of the organization.
- Gaining a comprehensive understanding of impacted stakeholders.
- Establishing a support and sponsorship framework to ensure long-term, successful adoption.
- Communicating effectively by understanding the organizational impacts of new technology from the perspective of executives, managers, and employees.

Course materials include templates that attendees can immediately use in their own change management efforts.

To learn more and register, visit esri.com/training.
Build Web Apps That Use All Kinds of Data

By Julie Powell

The ArcGIS API for JavaScript is flexible and interoperable. It enables you to build web apps with striking visualizations and interactive workflows using data in non-ArcGIS formats as well as ArcGIS layer types.

You can load GeoJSON and comma-separated values (CSV) files, and Open Geospatial Consortium, Inc. (OGC) services, and use third-party basemaps with a few lines of code and style them just as you would any ArcGIS layer type. Once you have the layer in your app, the world is your oyster. You can build a great user experience using client-side querying, statistical calculations, filtering, and geometric operations. Because non-ArcGIS layer types are fully integrated into the ArcGIS API for JavaScript, you can build your user interface (UI) using API widgets that work with these layers.

Consuming GeoJSON

GeoJSON was developed in 2008 through community discussion and consensus to include spatial data in the newly popular JavaScript Object Notation (JSON) format. GeoJSON offered web developers an easy way to extend existing APIs. It has been widely adopted across a variety of services, such as GitHub and Twitter, and used in visualization tools such as Data-Driven Documents (D3). Due to its popularity and interoperability, developers continue to build apps that bring in features represented as GeoJSON.

From the initial release of the ArcGIS API for JavaScript, developers could build web mapping apps that consumed GeoJSON directly, but they had to do a little work. Consuming GeoJSON required creating a custom layer in the map and manually loading, parsing, and styling features. GeoJSON uses World Geodetic System 1984 (WGS84), a geographic coordinate reference system, so the map was limited to WGS84 or web Mercator spatial references. Using another coordinate reference system would mean additional effort.

The ArcGIS API for JavaScript has evolved. It now provides a GeoJSON layer to fully support GeoJSON data sources. The GeoJSON layer allows you to easily pull in GeoJSON data by referencing the URL and adding the layer to the map (Fig. 1).

While GeoJSON data is limited to WGS84, thanks to the ArcGIS API for JavaScript, your map or basemap isn’t limited. It can be in any projection.
All the loading and parsing is handled by the API. Since the API has a client-side projection engine, it will automatically project the data to the map’s coordinate system as needed. While GeoJSON data is limited to WGS84, your map or basemap isn’t. It can be in any projection.

```javascript
const geojsonLayer = new GeoJSONLayer({
  url: "https://earthquake.usgs.gov/earthquakes/feed/v1.0/summary/all_month.geojson"
});
```

Fig. 1

The fun doesn’t end there. You can add pop-ups and labels and style features using the same techniques you use to visualize data in other layer types. You control how each attribute in GeoJSON data drives the color, size, opacity, and rotation of features. All smart mapping capabilities are available with GeoJSON layers.

**Data in 2D, 3D, or Both**

The ArcGIS API for JavaScript is multidimensional. You can choose to visualize data in 2D or 3D or give your users the option to interact with data in both 2D and 3D. Changing the code from a MapView to a SceneView will display the data in 3D. You can leave its appearance as is or style the layer with 3D symbols so it will nicely display on a 3D globe. 3D enables nontechnical stakeholders who may not understand maps to more easily understand context and analysis. With the ability to use elevation and high-resolution models, 3D can even be more accurate than 2D representations of the real world.

For example, the US Geological Survey recent earthquakes feed includes elevation information that provides the distance below the earth’s surface. You can use the elevation information to set the depth of each feature and interact with the data underground in a 3D scene. Take it a step further and use the magnitude of the earthquake to drive the size and color of the features. Looking at this visualization, you can really get a sense of the movement going on below the surface, even if you didn’t feel the shaking.

With your layer set up, you decide what map interaction you’d like to enable in your app. The GeoJSON layer loads all data at once to the client. You can build a very interactive experience using the API’s client-side querying, statistics, filtering, and geometric analysis.

**What about ArcGIS Online and ArcGIS Enterprise?**

Many organizations want to make their data available as GeoJSON (often along with other formats) so that any client that supports GeoJSON can consume this data as well as create and style layers in web maps from third-party GeoJSON sources. ArcGIS Online and ArcGIS Enterprise support GeoJSON as a format you can use to upload to create new hosted services in web maps, download existing content, or get query results.

**Bring CSV Data to Life**

CSV is a plain-text file format used to represent tabular data, including geographic point features (i.e., latitude and longitude).
Because of its simple structure, CSV is easy to generate, import, and export from programs that store data in tables such as Microsoft Excel. However, if you want to understand spatial patterns in data, it’s nearly impossible in a tabular format. If a CSV file has location data—place information, addresses, or x,y coordinates—you can map it. You can do everything with CSV that you can with GeoJSON.

There are a few ways to bring CSV data into your app. You can use the API’s CSV layer to load the CSV by specifying the URL where the file is stored (Fig. 2). Note that the CSV layer expects latitude, longitude coordinates. If the basemap and the CSV data have different spatial references, the CSV data will automatically be reprojected on the client-side, as with GeoJSON.

Another way to bring in CSV data is via a layer or web map you create in ArcGIS Online or ArcGIS Enterprise. An easy way to do it is by uploading the CSV file and creating a hosted feature layer (Fig. 3). If the CSV data has addresses or place-names, it will be geocoded. Once the data is in your map, you can use smart mapping tools to style the layer, add pop-ups, and do other things. The saved layer or web map can be loaded into your app as usual and the API will apply anything that has been configured.

![Fig. 2](image2.png)

**OGC Services**

Using OGC services and encodings enables open access to geographic data and software functionality, allowing organizations to incorporate GIS data and services into any app on a variety of computing and mobile devices. These open services and encodings improve the sharing and interoperability of geospatial information. With ArcGIS, you can publish your data as OGC endpoints as well as ArcGIS service types. For example, you can publish a hosted ArcGIS Online or ArcGIS Enterprise Web Feature Service (WFS) from a hosted feature layer and Web Map Tile Service (WMTS) from a tiled layer.

A smart practice is to enable both the ArcGIS and OGC service types so that client apps that are built with ArcGIS service types can benefit from performance and capability advantages, while non-ArcGIS clients can still interface with the OGC service types.

OGC layers (of any origin) can be brought into your web app by adding them to a web map in ArcGIS Online or ArcGIS Enterprise. Load these layers with a few lines of code or by manually creating layers in your app that directly reference the services. The ArcGIS API for JavaScript supports Web Map Service (WMS), WMTS, WFS (available in version 3.x and coming soon in 4.x), and KML. OGC layers are well integrated into the API. For example, the design of the WMS layer was modeled after the ArcGIS dynamic service-based map image layer. You can work with WMS sublayers in a way that is very similar to how you work with map image layer sublayers. These layer types, in addition to any sublayers, will be
Visualizing the Big One

When earthquakes occur, we often focus on the “big one,” but it is interesting to explore other nearby earthquakes to gain a broader perspective on spatial and temporal seismic patterns underground. Using the most current earthquake GeoJSON feed from the US Geological Survey (USGS), this app visualizes the largest earthquake that occurred anywhere in the world within the last week along with all smaller earthquakes from the same area and time period.

A variety of capabilities in the ArcGIS API for JavaScript are employed to provide this rich user experience. The GeoJSON layer is used to load and parse the USGS earthquake GeoJSON data. Using client-side queries and statistical calculations, the app finds the strongest earthquake in the last week and identifies the other earthquakes that occurred during that week. The magnitude of each earthquake drives the size and color used to display each feature. The larger and redder the symbol, the greater the magnitude.

In addition to earthquake locations, the USGS feed contains links to multiple supporting GeoJSON datasets, which are dynamically loaded by the API. One of these datasets, a shake map, indicates the intensity of ground shaking surrounding an earthquake. The shake map is thematically drawn using a 3D path symbol with a continuous color ramp that indicates the intensity of each band.

To let users explore above and below ground, earthquakes are visualized in a 3D scene that includes a clipped area of imagery for the land above the earthquake epicenter. With the app’s time slider, users can progressively display earthquakes that occurred throughout the week. With each adjustment of the time slider, the time extent changes and data is filtered accordingly. Because the time slider works with the data on the client side, map updates happen instantaneously.


About the Author
Julie Powell is a technical product manager who works primarily on the ArcGIS API for JavaScript. She has more than 17 years of experience working with software development, delivering solutions for both enterprise and consumer markets. Powell has worked on a wide range of projects and consulting endeavors, including serving as a technical lead for web mapping solutions for strategic customers. She interfaces with the user community to maintain awareness and insight into GIS community needs, meanwhile contributing feedback to development teams to help ensure users can be successful in building state-of-the-art, purposeful solutions using ArcGIS software.
The release of ArcGIS Runtime SDKs 100.6 is a major milestone in terms of the capabilities it adds and in how Esri will plan the content of releases going forward. This version introduces a track-focused road map. For 100.6, these tracks are:

- Utilities
- Public safety and defense
- ArcGIS platform support

While these tracks were the drivers for the capabilities added at this release, the new capabilities have broad applications.

Work with ArcGIS Utility Network Management

For the first time, ArcGIS Runtime SDKs expose the capabilities of ArcGIS Utility Network Management extension, Esri’s new technology for managing, analyzing, and representing operational networks. You can now write mobile apps that not only allow you to display and interrogate networks, but also perform traces against them.

Esri provides APIs to read network properties and definitions and understand associations between network elements and between network elements and their geographic feature representations. APIs for network tracing were also added. Set one or more start points on a network (either on a junction or a terminal or along an edge), and (optionally) any number of barriers, and perform a trace. Traces are lightning fast but this only hints at future ArcGIS Utility Network Management capabilities.

At this release, all ArcGIS Utility Network Management capabilities are service based and require a network connection. More capabilities, including working offline, will be added in future releases. Additional ArcGIS Runtime SDK samples will be available to show you how to take advantage of this major new technology.

The previous release introduced annotation and reference scale, which support working with utilities. Annotation support is improved at the current release with the ability to take annotation services offline and work with annotation sublayers. Taking annotation offline is a read-only workflow for now. An ArcGIS Runtime SDK app can be updated by being synchronized with an annotation service. These capabilities will expand over the next few releases.

Navigation enhancements were also driven by utility customers but have a broad range of applications. Developers working with the ArcGIS Runtime SDKs have long been able to provide turn-by-turn directions, when connected and when offline, but developers have had to write a fair bit of custom code to provide an interactive navigation experience.

The new Navigation API makes it easy to integrate navigation directly into a ArcGIS Runtime app. Note: Using the Navigation API in a production app requires licensing an ArcGIS Runtime SDK at the Basic level. This release includes APIs to alert you of upcoming maneuvers. It also detects when you’ve wandered off route and automatically re-routes you when using a local network dataset.

Offline capabilities have been driven by the requirements of utilities apps but are applicable to so many other use cases. This version introduces scheduled updates, which augment the preplanned offline workflow by generating and storing periodic read-only delta updates on the server that are ready for clients to download. An ArcGIS Runtime app can check with the server to see which updates will make it current, download them, and apply them in sequence.

Scheduled updates take advantage of the preplanned offline workflow performance benefits of “generate once, distribute
This update to the ArcGIS Runtime SDKs introduces network tracing. Users can set a starting point on their network, specify any number of barriers, and then perform a trace.

broadly.” A client won’t have to choose between waiting for the next scheduled full replica to be generated or kicking off a sync, which places a burden on the server and doesn’t scale the same way as the preplanned workflow does.

Scheduled update deltas can coexist alongside preplanned replicas. ArcGIS Runtime SDKs will intelligently make local data current by determining if it is better to download the latest replica or download a sequence of deltas. Adding support for scheduled updates adds access to an offline geodatabase’s generation ID. Now ArcGIS Runtime apps will cleanly close mobile map packages (MMPKs). Esri also included memory usage and performance improvements (particularly with symbology) when parsing MMPKs.

Over the last year, more than 300 people participated in AR/VR in ArcGIS Runtime, the augmented reality/virtual reality Esri Early Adopter program. With 100.6, those capabilities are out of beta and ArcGIS Runtime is AR enabled for iOS and Android devices.

Delivering a truly exceptional AR experience across a range of use cases requires customization, configuration, and calibration. To support that, Esri will be providing rich open source toolkit components to help build tabletop and full-scale AR experiences on top of the base components the ArcGIS Runtime SDKs expose.

Public Safety and Defense
Driven by a specific set of mission-critical requirements, public safety and military symbology must be highly readable and immediately recognizable. It must cover a range of expected and unexpected situations because the stakes for misreading a map often cannot be higher.

With 100.6, Esri introduces improved support for this symbology that is being built into the entire ArcGIS platform, which uses a dictionary renderer to access symbols in a style file and is powered by ArcGIS Arcade. This enhancement exposes complex attribute-driven rendering for use in any kind of app.

Use Arcade to define dictionary-driven, complex symbology using multiple feature attributes. For example, with a little Arcade customization, you can directly symbolize restaurants on the map and show not only locations and types but also ratings and whether a restaurant is currently open.

Many Open Geospatial Consortium, Inc. (OGC) services use parameter-based authorization schemes for access. Esri now supports the use of these authorization keys, as well as any custom parameters, for Web Feature Service (WFS), Web Map Service (WMS), and Web Map Tile Service (WMTS) layers.

With this release, you can modify a KML file or author one from scratch, save it, and share it with others directly from a ArcGIS Runtime SDK app. Note: Creating and editing a KML file in a production app requires licensing an ArcGIS Runtime SDK at the Standard level.

ArcGIS Platform Support
This release also adds capabilities that are driven by the ArcGIS platform:

- MMPKs now support Group layers.
- ArcGIS Runtime SDKs open WFS layers from a web map.
- You can identify and select features in a point scene layer.
- Scene layers, feature layers, and graphics overlays can have a vertical offset defined for use in a scene.
- Various line styles and symbology sets have been updated.
- Esri has fixed multiple bugs and made improvements in performance and memory usage, particularly in the use of dictionary renderers, Arcade, and when working with MMPKs. See the release notes for Android, Qt, .NET, Java, and iOS SDKs for specific details.

Get Started
To get 100.6, go to the ArcGIS for Developers (developers.arcgis.com/arcgis-runtime) website, browse to the ArcGIS Runtime SDK page of your choice, and download the SDK. You can also refer to that Gamma it through NuGet, Gradle, or CocoaPods. If you’re new to developing with ArcGIS Runtime SDKs and don’t have an ArcGIS for Developers subscription, simply sign up at developers.arcgis.com sign-up for a free account. You’ll be able to access everything you need to develop your app.

About the Authors
Nick Furness is a technical product manager for ArcGIS Runtime SDKs for iOS and macOS. He has spent more than 20 years working in GIS, building projects that have ranged from small, mom-and-pop solutions to enterprise utility and national government deployments.

Rex Hansen is a product manager for ArcGIS Runtime SDKs. He has more than 25 years of experience in GIS, spatial analytics, and computer mapping. He has helped guide the development of native solutions and technologies in the GIS industry that use authoritative geospatial data in immersive, extended reality experiences.

This release includes APIs that detect when you’ve wandered off route and automatically reroute you when using a local network dataset.
Finding the Perfect Spot
Pennsylvania Plants Trees Precisely with GIS
By Josh VanBrakle

Where is a good place to plant streamside forests? The answer could be, “Just about anywhere.”

Trees are natural water filters. They improve water quality; reduce flooding impacts; stabilize soils; provide wildlife habitat; and are vital to healthy streams, rivers, and bays. Streamside forests naturally block and break down many pollutants before they ever reach the water.

Although planting trees along streams is one of the most effective ways to improve water quality, establishing them is expensive and time-consuming. Planting alone can cost more than $2,000 per acre, and trees require several years of maintenance to ensure their survival.

Given these costs, it makes sense to select planting sites that maximize the water quality gains of every tree planted. While anywhere along a stream may be adequate, some spots are better than others. Topography, soil, climate, and upland land use all impact how much pollution a given streamside forest can filter. GIS and high-resolution data can help land managers target planting sites to maximize water quality gains for every tree planted.

Using GIS for Planting Planning
Pennsylvania has set an ambitious goal of planting 95,000 acres of streamside forests by 2025. But where are the best spots for those forests? The state turned to GIS for the answer. The result was a comprehensive statewide database of over 200,000 planting opportunities—each ranked by its ability to improve water quality.

To prioritize planting sites, the first step was to find them. Traditional 30-meter land-cover data from the National Land Cover Database (NLCD) was too coarse for the analysis, so it was replaced with new, 1-meter land-cover data developed for Pennsylvania by the Chesapeake Conservancy and University of Vermont. This new land cover data provided 900 times the precision of the NLCD and allowed for detailed delineation of planting sites. Areas of at least 0.25 acres of low vegetation (plant material less than 2 meters in height) on a single tax parcel
were evaluated.

To identify potential planting sites, 1-meter land-cover data was intersected with 100-foot buffers around streams, rivers, and water bodies. All land cover other than low vegetation was removed, and the results were intersected with tax parcels to locate planting sites.

Once planting sites were identified, they were ranked using three criteria:
1. **Topographic wetness index**—How well the site mitigates storm water
2. **Sediment trapping efficiency**—How well the site filters pollution
3. **Upslope land cover**—How much need for pollution control exists at the site

The topographic wetness index uses a digital elevation model (DEM) to calculate how much water flows through a given streamside area on its way to the stream. The more water that flows through an area, the more important a streamside forest is at that location.

To calculate the topographic wetness index, tools available from the ArcGIS Spatial Analyst license for ArcGIS Pro were used. The DEM is corrected using the Fill tool to remove sinks (i.e., erroneous low points in the data). The resultant filled DEM
The process for calculating topographic wetness index for the Schuylkill River Watershed, Pennsylvania, starts with (A) a filled digital elevation model that is used to generate a (B) slope raster and (C) flow direction raster. Flow direction is then used to create (D) a flow accumulation raster. Raster Calculator is then used to calculate (E) a topographic wetness index from the slope and flow accumulation rasters.

Sediment trapping efficiency assesses how effectively a streamside forest can block pollution delivery to streams via surface and shallow subsurface flow. It uses soils data including median particle size, runoff potential, erodibility, slope length, and slope steepness. The US Natural Resources Conservation Service Gridded Soil Survey Geographic (gSSURGO) Database provided this information. The Raster Calculator in ArcGIS Pro was used to combine the disparate variables into a single sediment trapping efficiency score.

In the last step, identifying the upslope land cover flagged planting sites where upland land uses were more likely to
generate pollution. It paired the 1-meter land-cover data with National Hydrography Dataset catchments to identify catchments with higher developed and agricultural land. Planting sites in these catchments received higher scores than those with more natural land covers such as forests.

The scores for each criterion ranged from 0–1. These scores were summed into a final score for each planting site. Higher total scores indicated sites that could effectively filter more pollution from a larger amount of water.

Sites also received qualitative attributes to aid end users in navigating the data. These

> Sediment trapping efficiency was determined using rasters for (A) soil particle size, (B) runoff potential, (C) soil erodibility, and (D) slope length. (E) The Raster Calculator was used to combine these datasets into a single score.

> Heat map symbology in ArcGIS Online turns an otherwise meaningless mass of 200,000 data points into a simple-to-explore product.

> Heat maps and the Filter widget pair beautifully to remove all planting sites outside the Perkiomen Creek Watershed area.
attributes included geographic regions (county, watershed), stream health (determined by the Pennsylvania Department of Environmental Protection), urbanized areas (from the US Census), and protected land status (based on Pennsylvania’s PA Conserved Land database).

Sharing Results
A key goal of the project was to make results accessible to non-GIS users. The project sought to help local organizations—often volunteer-based conservation groups—find and select planting sites in their communities. To meet this goal, the analysis results were made available in a web app, Pennsylvania Streamside Tree Planting Prioritization, at conservationtools.org/cms/maps-gis. The app was built using Web AppBuilder for ArcGIS. Advanced users can download GIS layers from the Pennsylvania Spatial Data Access website.

The amount of information provided by the dataset made creating a web app challenging. Users needed to efficiently sift through 200,000 potential sites to find a few relevant locations. A combination of heat maps and filters met that requirement while simultaneously reducing the app’s load time.

Planting site polygons are only displayed at very large scales. At smaller scales, the point layer displays as a heat map. To accomplish this, site polygons were converted to point features using the Feature To Point tool in ArcGIS Pro.

Heat mapping in ArcGIS Online includes the ability to map based on an attribute as well as by point density. At the smallest scales, map filters limit the points used by the heat map to the highest scoring sites to improve performance. By choosing the site’s score for this attribute, the heat map shows clusters of high-scoring locations, which is ideal for locating planting sites. As users zoom in, the heat map adjusts to continue showing high-scoring areas. The result is a seamless exploration from the statewide to local levels.

Heat maps in ArcGIS Online also respond dynamically to any filters applied to the layer they symbolize. Multiple filters can be applied to the heat map simultaneously. This capability proved essential for tree planters. For example, conservation groups in Pennsylvania often focus on one watershed. By filtering results using either hydrologic unit code (HUC) number or name, these groups can cut through the data noise and find exactly the planting sites they are interested in.

To maximize web app performance, planting site polygons only display at the largest scales and are symbolized according to total score (A). At this scale, users can switch to aerial imagery to select and study a potential site (B).
State agencies prefer to plant trees on land that has already been protected from development such as a local park or land with a conservation easement. Filtering the heat map by protected land status allows these users to find clusters of quality protected planting sites on the fly.

Project Benefits
Completed in June 2019, this project took one analyst six months. It is already in use, guiding planting efforts. Recently, staff from the Pennsylvania Department of Conservation and Natural Resources used the data to locate planting opportunities on parks in York County. They then ground truthed the GIS results by visiting several parks. Having validated the data, the agency is applying the GIS model to prioritize planting on state-owned lands.

This project illustrates the dual power of ArcGIS to perform analysis requiring advanced geoprocessing tools, complex math, and high-resolution data and yet communicate the results of that analysis intuitively, using a responsive and easy-to-navigate interface. This will allow Pennsylvania to tailor its conservation investments and ensure that every dollar spent works as hard as it can to make the state’s streams, lakes, and rivers cleaner for everyone.

For more information, contact Josh VanBrakle, GIS specialist for the Pennsylvania Land Trust Association, at jvanbrakle@conserveland.org.

About the Author
Josh VanBrakle is a GIS specialist at the Pennsylvania Land Trust Association. He holds a bachelor’s degree in environmental economics and policy from Lebanon Valley College and a master’s degree in natural resource management from the State University of New York.
Three Valley Conservation Trust (TVCT), a nonprofit land conservation organization in Oxford, Ohio, needed to identify and prioritize land parcels for conservation easements that would help protect streams and riparian zones, promote prime production of agricultural land, and decrease the potential for habitat fragmentation.

Nonprofit land trust organizations, such as TVCT, implement environmental planning by working toward permanently preserving habitat, open space, and dynamic landscapes on private land, using different conservation strategies such as conservation easements. This strategy permanently limits land uses through a custom legal agreement to protect the natural and/or agricultural values of the land. According to the Land Trust Alliance, in 2018 there were 1,363 land trusts in the United States.

Easement acquisition is restricted by limited funding sources. Land managers are tasked with maximizing efficiency in the conservation planning process by prioritizing areas with high ecological value. Local land conservation organizations like TVCT can benefit from prioritization tools that enable data-driven decision-making.

**Three Valley Conservation Trust**

Founded in 1993, TVCT primarily targets riparian habitat and agricultural land in southwest Ohio. It protects land through conservation easements that span seven counties in southern Ohio and Indiana. TVCT’s goal is to implement widespread protection of open space, watersheds, and communities for present and future generations.

The land trust works toward this goal through sale or donation of conservation easements. Leveraging federal and state grant funding, TVCT places permanent easements on private property. Its funding comes from organizations and agencies such as The Nature Conservancy (TNC), the Ohio Environmental Protection Agency (OEPA), and the Local Agricultural Easement Purchase Program (LAEPP).

To more effectively spend its available funds, TVCT wanted a parcel prioritization tool.
tool developed that would assist in targeting easement placements. A research assistantship was granted to Meghan Jones, a graduate student at Miami University, who would undertake development of this tool for her master’s thesis. She created the prioritization tool using Esri’s ModelBuilder, saving TVCT both time and money.

Creating the Priority Model

The tool, the Land Priority Protection Model (LPPM), utilizes ModelBuilder in ArcMap 10.6 to identify areas of land best suited for conservation. It applies conservation criteria to private land to weight, rank, and strategically score parcels. The decision support criteria are the fundamental components of LPPM.

TVCT identified three overarching evaluation criteria for identifying potential parcels of high value: presence of streams, adjacency to existing protection, and the presence of desirable land-cover/land use (land cover/land use types include wetland, forest, and agriculture use). Each criterion is evaluated within its own submodel and calculated individually. The final conservation model is computed last to accommodate all other criteria calculations. While the primary purpose of the model is to identify high-priority land to apply conservation easements, the model needed to be versatile so that variables can be excluded or weighted differently.

Three Valley Conservation Trust is a nonprofit agency with limited funding. It favors using publicly available data sources such as the National Land Cover Database and the National Hydrography Dataset for analysis. Some of the open data sources are listed in Table 1. All data utilized was-collected through free national or state platforms; this is very important to the land trust for several reasons such as cost, availability and reliability. After collection, all data were imported into ArcGIS and reprojected to NAD83 Ohio South State Plane Feet, clipped to the study area, and imported into a geodatabase before being included in the model.

ModelBuilder as a Useful Solution

ModelBuilder was chosen as the main platform for data manipulation and analysis for its versatility. Several toolbox tools with different workflows were created, which cut down the time that would normally be spent opening and running separate tools. ModelBuilder is a visual workflow creator that offers a flexible interface, providing easy editing and streamlining automation of frequently run processes. Users can assess conservation criteria individually and together.

LPPM automates the process of prioritizing parcels based on various conservation scenarios. When using the submodel, the user determines whether to include or exclude criteria and assigns relative weights to each criterion. For example, if a funding agency prefers different conditions or criterion weight for conservation easement applications—such as the presence of wetlands—those variables can be weighted higher before running the final priority model.

Submodels for Individual Conservation Criterion

Each criterion for identifying potential parcels of high value is handled by a submodel. Each submodel has a specific purpose: to create an attribute field for holding score. For example, the Presence of Streams submodel selects every parcel in the study area that intersects a stream and assigns it a score of 100 because a stream is present. All parcels that don’t intersect a stream receive a score of 0, denoting the absence of streams.

After each submodel has been run, the parcel dataset contains five new fields that hold scores for each evaluation criterion. The appended parcel dataset is then used to run the final conservation model.

Final Model and Results

The final analysis adds a field to the parcels dataset to store the final priority score.

<table>
<thead>
<tr>
<th>Conservation Criteria</th>
<th>GIS Data</th>
<th>Source</th>
<th>Data Type</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presence of streams</td>
<td>The National Hydrography Dataset</td>
<td>USGS The Natinal Map <a href="https://hydro.nationalmap.gov">https://hydro.nationalmap.gov</a></td>
<td>Vector</td>
<td>1:24,000</td>
</tr>
<tr>
<td>Adjacency to existing protection</td>
<td>1. TVCT existing protection 2. Other private protection 3. Public land protection</td>
<td>Three Valley Conservation Trust Ohio-Kentucky-Indiana (OKI) Regional Planning Authority</td>
<td>Vector</td>
<td>1:24,000</td>
</tr>
</tbody>
</table>
score is calculated as a sum of each criterion present for each parcel multiplied by the individual weight assigned, which ranges from 0–100. A weight of 100 represents the most desirable land for conservation, and a weight of 0 represents the least desirable land for conservation. Results are symbolized in even quantiles from 0–100 based on the final conservation index parcel score. Of 201,477 parcels evaluated, only 514 (0.2 percent) scored a perfect 100, while 3,777 parcels (1.87 percent) contained the highest priority score ranging from 75–100.

**Passive to Active Planning Approaches**

Prior to the completion of LPPM, TVCT primarily followed a passive approach to land conservation, relying on landowners to initiate the decision to protect property from development and begin habitat restoration. While this resulted in more than 23,000 acres being placed in conservation easements, this approach does not always protect higher-risk ecosystems and can result in habitat gaps.

By utilizing LPPM, TVCT can analyze open-source data and identify at-risk ecosystems. Mapping natural resources using weighted criteria helps illustrate how

→ Conservation easements permanently limit land uses through a custom legal agreement to protect the natural and/or agricultural values of the land. This agricultural land in southwest Ohio is protected under a conservation easement. Photo courtesy of Three Valley Conservation Trust

↑ Visual workflow of Land Priority Protection Model construction. Each submodel evaluates an individual conservation criterion and creates a field in the parcel dataset attribute table with a presence-absence score. These scores are analyzed in the final model.
private parcels of land impact biodiversity and ecosystem services on a landscape level. For example, this model could provide the land trust with a way to examine which parcels should be set aside to provide contiguous habitat along a riparian corridor, rather than focusing on land use/land cover.

Conservation funding is limited and so is the amount of land it can ultimately protect, so it is important that TVCT scrutinize available funding projects and protect parcels that will provide the greatest ecological benefit. LPPM allows TVCT to be proactive and educate landowners who may be less inclined to support local land protection on the ecological value of their property. Engagement and education aim to increase involvement with the community to promote habitat preservation or protection.

Leveraging model results, the land trust shifted from predominantly passive methods to proactively seeking out appropriate land for conservation and then finding a funding source to aid in the easement acquisition. The maps created using LLPM will help communicate land protection issues as they relate to landowners’ holdings, and target donors for restoration projects.

Following the initial analysis and selection of strategic habitat using the LPPM, TVCT exported the selected parcels to unmanned aerial systems (UAS) mapping software loaded on Apple iPads. The staff used UAS technology and software to obtain current aerial images and vegetation indexes. In addition, field staff used the maps to guide biological surveys, draft habitat restoration/protection plans, and create detailed presentations for meetings and workshops.

### The Future Use of LPPM

Going forward, TVCT plans to continue employing the LPPM as a means to identify habitat zones hosting vital or at-risk native flora and fauna. As funding sources are identified, the conservation trust will adjust data layers and feature class weights to align strategic mapping with funding partner criteria. This flexibility allows TVCT to maximize its impact by leveraging collaborative funding from multiple sources. LPPM helps visually communicate conservation initiative goals, illustrate the initial planning and assessment steps, and significantly increase community outreach and financial support.

LPPM is free to access, and a step-by-step user guide helps GIS technicians at partner conservation groups re-create the methods used in this analysis and incorporate industry data layers. [See the online version of this article at esri.com/arcuser for links to the model, guide, and resources consulted.]

For more information, contact Meghan T. Jones at taylormegh7@gmail.com.

### Acknowledgments

This work was completed under the guidance of Robbyn Abbitt, GISP, the GIS coordinator and master’s research adviser in geography at Miami University in Ohio.

### About the Author

Meghan T. Jones is a GIS specialist with LJB Inc., a consulting firm that provides civil and structural engineering, environmental, and safety services. She has bachelor’s and master’s degrees in geography and a certification in GIS from Miami University, Ohio. Jones is a board member of the Young Professionals Network at LJB. She works to promote continuing education, social and professional engagement, and mentorship among emerging professionals. She uses GIS to build web applications, create spatial analysis models, and apply automated scripting.
Making a Precision Reference Map in ArcGIS Pro

By Mike Price and Amelia A. Fox

This tutorial walks you through the process of obtaining, managing, and mapping county-level data from a statewide spatial data site to generate a precision reference map. In this exercise, you will map data for Bolivar County, Mississippi.

One of the authors, Mike Price, offered to convert several exercises in a textbook written by the other author, Amelia A. Fox, from ArcMap to ArcGIS Pro. This supplied the impetus for this article. Fox, an assistant professor at Mississippi State University (MSU), developed a series of exercises applying GIS to precision agriculture that were compiled into Precision Agriculture GIS Technologies for Mississippi, First Edition. To learn more about her work and the program at MSU, read the article, “Mississippi State University’s Precision Agriculture Program,” in this issue of ArcUser.

Getting Started

Begin by downloading the dataset for this tutorial from the online version of this article at esri.com/arcuser. Unzip the archive in a separate area of your computer dedicated to training, and preserve the folder structure. This archive contains a layer file that you will use to symbolize spatial data downloaded from the MARIS spatial data site.

The goal of this exercise will be to create and populate a reference map to support agricultural mapping throughout Mississippi. Vector data for Bolivar County, which is located along the Mississippi River in the west central portion of the state, will be downloaded from Mississippi’s statewide geographic information system. You will learn how to manage, symbolize, and display vector data. Download and unzip the archive for the sample dataset.

1. Start ArcGIS Pro.
2. Click Map and create a new project named MS_Ag_Reference.
3. Store the project in the MS_Ag_Technology folder created when you unzipped the sample dataset.
4. When the map opens, the Topographic basemap is displayed by default. Zoom to center on the state of Mississippi. Set a preliminary proportional scale of 1:3,000,000.

Defining a Reference Coordinate System

Now, let’s enhance a statewide reference map. Since precision agriculture field data is often collected using GPS-equipped farm equipment or drones, reference coordinate systems, including modern horizontal and vertical datums, must be carefully considered. In the US, agricultural measurements are often collected
and reported in Imperial units (e.g., feet, acres, bushels). However, metric units will be assigned to this reference map and ArcGIS Pro facilitates fast and accurate conversion between the systems.

At MSU, instructors often apply a universal transverse Mercator (UTM) projection and the World Geodetic System (WGS) 1984 datum, with base units in meters. The central meridian of UTM Zone 15N is -93 degrees, and the eastern edge of this zone is -90 degrees, so Zone 15N includes the western portion of Mississippi. Because the initial map includes the western third of the state, using Zone 15N makes sense. If mapping eastern Mississippi, it would likely be better to switch to Zone 16N.

Although the North American Vertical Datum (NAVD) is scheduled for replacement in 2022, for this exercise, use NAVD 1988. [To learn about the adoption of the new datums in 2022, read “Moving from Static Spatial Reference Systems in 2022” in the Winter 2019 issue of ArcUser.] To set the vertical datum, select the button under Current Z and expand Vertical Coordinate System > North America and choose NAVD 1988. Click OK and save the project. After defining this projected coordinate system, let’s set a bookmark for Mississippi. Use the Navigate tool to pan and center on the state boundary. Type “2500000” in the Scale box, and watch

Table 1: Bolivar County MARIS Data

<table>
<thead>
<tr>
<th>MARIS Bolivar County Dataset Name</th>
<th>MARIS Coordinate System</th>
<th>Feature Type</th>
<th>Export Feature Class Name</th>
<th>Final Contents Order</th>
<th>Final Map Feature Class Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>stowns_11</td>
<td>mstm</td>
<td>Point</td>
<td>stowns</td>
<td>1</td>
<td>Towns</td>
</tr>
<tr>
<td>transm_11</td>
<td>mstm</td>
<td>Polyline</td>
<td>transm</td>
<td>6</td>
<td>Transmission Lines</td>
</tr>
<tr>
<td>railrds_11</td>
<td>mstm</td>
<td>Polyline</td>
<td>railrds</td>
<td>5</td>
<td>Railroads</td>
</tr>
<tr>
<td>NHDFlowline16_11</td>
<td>NAD_1983_Mississippi_TM</td>
<td>Polyline</td>
<td>NHDFlowline16</td>
<td>4</td>
<td>NHD Flowlines</td>
</tr>
<tr>
<td>desig_hwys_11</td>
<td>NAD_1983_Mississippi_TM</td>
<td>Polyline</td>
<td>desig_hwys</td>
<td>3</td>
<td>Major Highways</td>
</tr>
<tr>
<td>ccords_11</td>
<td>mstm</td>
<td>Polyline</td>
<td>ccords</td>
<td>2</td>
<td>County Roads</td>
</tr>
<tr>
<td>pop_pl_11</td>
<td>mstm</td>
<td>Polygon</td>
<td>pop_pl</td>
<td>11</td>
<td>Populated Places</td>
</tr>
<tr>
<td>pls_11</td>
<td>mstm</td>
<td>Polygon</td>
<td>pls</td>
<td>8</td>
<td>PLSS Sections</td>
</tr>
<tr>
<td>NHDWaterbody16_11</td>
<td>NAD_1983_Mississippi_TM</td>
<td>Polygon</td>
<td>NHDWaterbody16</td>
<td>10</td>
<td>NHD Waterbodies</td>
</tr>
<tr>
<td>NHDAreas16_11</td>
<td>NAD_1983_Mississippi_TM</td>
<td>Polygon</td>
<td>NHDAreas16</td>
<td>9</td>
<td>NHD Water Areas</td>
</tr>
<tr>
<td>co_11</td>
<td>mstm</td>
<td>Polygon</td>
<td>co</td>
<td>7</td>
<td>Bolivar County</td>
</tr>
</tbody>
</table>

In the contents pane, right-click Map and select Properties. In the Map Properties window, click the General tab, and name the map MS AG Reference Map—a short and concise name is good. Also, set the map and display units to meters.

Next, click Coordinate Systems and notice that the current coordinate system is WGS 1984 Web Mercator Auxiliary Sphere, which was set by default because it is the coordinate system of the Topographic layer. To set the coordinate system to UTM Zone 15N, select the button under Current XY and expand the folders in the pane under XY Coordinate Systems Available. Choose Projected coordinate system > UTM > WGS 1984 > Northern Hemisphere and select WGS 1984 UTM Zone 15N.

Hands On

Download data for Bolivar County from the Mississippi Automated Resource Information System (MARIS) spatial data site.

| Download data for Bolivar County from the Mississippi Automated Resource Information System (MARIS) spatial data site. |

In the contents pane, right-click Map and select Properties. In the Map Properties window, click the General tab, and name the map MS AG Reference Map—a short and concise name is good. Also, set the map and display units to meters.

Next, click Coordinate Systems and notice that the current coordinate system is WGS 1984 Web Mercator Auxiliary Sphere, which was set by default because it is the coordinate system of the Topographic layer. To set the coordinate system to UTM Zone 15N, select the button under Current XY and expand the folders in the pane under XY Coordinate Systems Available. Choose Projected coordinate system > UTM > WGS 1984 > Northern Hemisphere and select WGS 1984 UTM Zone 15N.

Although the North American Vertical
the map reposition. Name the bookmark Mississippi 1:2,500,000 and type “State of Mississippi 1:2,500,000 UTM WGA 1984 Zone 15N Meters” as its description. This bookmark will work if you change the coordinate system to Zone 16N.

Don’t Skip Metadata

Let’s get serious about metadata for this map. Reopen Map Properties, click Metadata and type “Mississippi Precision Agriculture Technologies Reference Map” in the Title box, and copy and paste it into the boxes for Tags, Summary, and Description. In the Tags box, split the text with commas (i.e., Mississippi, Technologies, Reference Map). In the Credit box, type “Mississippi State University, MS MARIS, USDA SSURGO” and add your name. In the Use limitations box, type “For educational and training purposes only.” Click Generate Thumbnail.

Click OK to apply updates, save the project once more, and close ArcGIS Pro. Do this because the data that is downloaded in the next step will be stored in new folders. Reopening ArcGIS Pro will refresh the folder structures and show those new folders.

Adding simple metadata is not difficult and very important. For more information on this topic, read and work the companion exercise, “Create and Manage Metadata in ArcGIS Pro,” in this issue. This tutorial also uses MS MARIS data.

MARIS

Data for Bolivar County will be downloaded from the Mississippi Automated Resource Information System (MARIS) spatial data site. The MARIS Technical Center provides web access to Mississippi’s statewide GIS. MARIS data may be downloaded in shapefile or raster formats for personal and educational use. MARIS vector data is derived from US Census TIGER files, the National Hydrography Dataset (NHD), and other sources. This data is in Mississippi Transverse Mercator System (MSTM). Federal Geographic Data Committee (FGDC)-compliant metadata is generally provided for this data.

→ Set geographic transformation to WGS_1984_(ITRF00)_To NAD_1983.
→ Add all 11 shapefiles to the map.

Locating and Downloading MARIS Data

The workflow for the MARIS data described in this exercise may be reapplied to any county in the state. Open a web browser and search for “maris mississippi gis data download.” This is an efficient search string that poses the classic questions of who, where, what, and why in a sequence that makes sense to any search engine. Apply the search to find the MARIS home page.

Click Download Data > County Data. The reference map will use vector data for Bolivar County, so locate and download the zipped dataset for Bolivar County. In Windows File Explorer, navigate to your training area and create a \MS_AG_Technology folder. Extract the zipped Bolivar data into \MS_AG_Technology\MARIS. Minimize Windows File Explorer and the web browser. Restart ArcGIS Pro.

Transforming and Standardizing MARIS Data

Reopen the MS_Ag_Reference project and inspect the MS Ag Reference Map. In the Map ribbon, choose Add Data > Data. Navigate to \MS_Ag_Technology\MARIS\Bolivar, select all 11 shapefiles, and add them to the map. The map zooms to Bolivar County, located east of the Mississippi River. Verify that 11 shapefiles are loaded. Do not resymbolize these shapefiles, as a layer file will be used later.

MARIS data has been projected in Mississippi Transverse Mercator System (MSTM) and North American Datum 1983 (NAD 1983). Since agriculture data is often collected by drones and portable GPS equipment, it must be properly transformed into WGS 1984. In Contents, open Properties for MS AG Reference Map and select Transformation. Because ArcGIS will be transforming across different datums, make sure ArcGIS Pro has set the WGS 1984 (ITRF00) to NAD 1983 transformation. If it has not been applied by default, select WGS 1984 (ITRF00) to NAD 1983 and apply it.
Inspect one of the Bolivar County MARIS shapefiles you just imported as a feature class. Right-click stowns_11 in the Contents pane and open Properties and click Source. Expand Data Source and Spatial Reference. The data type is shapefile feature class. The projected coordinate system is mstm, an abbreviation for Mississippi transverse Mercator. Review the other spatial reference parameters. Close the window.

Move down to NHDFlowlines16_11, open its properties, and look at its spatial reference. Unlike stowns_11, this shapefile’s projected coordinate system is NAD 1983 Mississippi TM. Careful inspection will reveal these are the same parameters—only the names are different. Unfortunately, this small difference may produce error messages when performing certain GIS tasks. Close the map properties and save the project.

Building a Precision Agriculture Reference Map
To create a new file geodatabase to store all MARIS data, open the Catalog pane on the View tab and right-click Databases > New File Geodatabase. Store the new geodatabase in \MS_Ag_Technology\MARIS\ and name it MARIS_Bolivar. The _Bolivar suffix protects the geodatabase from the separate MARIS folder and it will support layer file symbology for the county.

In the Analysis ribbon, open Environments to inspect Environments options. Set the Current and Scratch Workspace to MARIS_Bolivar.gdb. Set Output Coordinate System to Current Map (which is MS Ag Reference Map). Set Geographic Transformations to WGS_1984_(ITRF00)_To NAD_1983. Set Extent to Current Display Extent. Remember to update the extent if you decide to download and process a different MARIS county. Review, but do not change, the remaining Geoprocessing Environments. Close the Environments pane and save the project before continuing.

In the Contents pane, right-click stowns_11 and select Data > Export Features. On the Parameters tab of the Geoprocessing pane, Set Input Features to stowns_11 and the Output Location to MARIS_Bolivar.gdb, and name Output Feature Class stowns_11. Do not include _11 in any output file names. The _11 suffix is the county FIPS code for Bolivar County.

Still in the Geoprocessing pane, click the Environments tab and verify that the Output Coordinate System is WGS_1984_UTM_Zone_15N and Extent is set to As Specified Below. If not correct, fix this by choosing Projected coordinate system > UTM > WGS 1984 > Northern Hemisphere > WGS 1984 UTM Zone 15N so the correct transformation will be applied. Click Run and wait as ArcGIS Pro exports the shapefile to a geodatabase feature class. When
completed, remove stowns_11 and stowns from the Contents pane.

Repeat this same process to export the other 10 Bolivar County shapefiles. Check the Output Coordinate System on the Environments tab to ensure it is set to WGS_1984_UTM_Zone_15N and the Extent is set to As Specified Below. Remember to exactly copy the source name, without its FIPS code (_11), as the name for each new feature class. Remove the shapefile and new feature class from the Contents pane after processing each shapefile.

This is the most tedious portion of the exercise, so be patient and proceed carefully. Refer to Table 1 for information on file naming conventions or source coordinate systems.

Loading, Symbolizing, and Labeling MARIS Feature Classes

After exporting the last shapefile, co_11 to co, and deleting both layers, the map’s Contents pane will only contain the Topographic basemap. Do not save this project yet in case any exports failed. If any export fails, you can close the unsaved project, reopen it, fix any problems, and export again.

Now it’s time for the fun part—applying symbology. In the LLYRFiles folder, a single layer file, MARIS ReferenceGroup, will reload all 11 grouped Bolivar County feature datasets in the order shown, with standard symbology and some labels. By pointing each feature class to its appropriate dataset, you can use this layer file to load MARIS data for any county.

Open Add Data and navigate to \MS_Ag_Technology\LLYRFiles. Add the MARIS Reference Group to Contents. Once loaded, note that all 11 feature layers have red exclamation points denoting broken data links. Instead of repairing each link individually, it is much easier to repair all 11 in one procedure. The Change Data Source tool in ArcGIS Pro can be used to update all 11 feature classes at once.

Bolivar County reference data is nearly complete, so let’s bookmark the county. In Contents, right-click Bolivar County and choose Zoom To Layer. Adjust the scale to a round number. In the Map ribbon, choose Bookmarks > New Bookmark. Name the bookmark Bolivar County, Mississippi with the scale, and type a description for it.

Let’s perform some housekeeping chores. Right-click MARIS Reference Group, open Properties, and change Name to MARIS Bolivar County Group. Switch to Metadata, and populate metadata fields in the same way you did when creating the map. Make sure to create a thumbnail. Save the project one more time.

On Your Own

You have created a precision reference map for Mississippi that is designed to obtain, manage, and map county-level data from a state data provider. In this exercise, you mapped data for Bolivar County. On your own, select another county and repeat the process.

Remember to create a new county geodatabase, change the Geoprocessing Environment Current and Scratch directories, and update the processing extent to match the county you chose. If you pick a county that lies east of -90 degrees longitude, update the Output Coordinate System to WGS 1984 UTM Zone 16N.

Follow standard naming conventions previously described so you can use the MARIS Reference Group Layer file to symbolize the county you chose. Finally, don’t overlook metadata. When you see a Metadata tab in any pane, open it, and update as necessary.

The companion exercise, “Create and Manage Metadata in ArcGIS Pro,” in this issue uses MARIS data for Warren County. You can use the data from that tutorial to try this tutorial’s procedures on your own. If you like fluvial geomorphology, you will appreciate the very interesting landforms of the Mississippi River.
Summary and Acknowledgments
This exercise uses data from MARIS and replicates the workflow developed by one of the authors (Fox) and the staff at MSU’s Precision Agriculture Program. That workflow appears in Fox’s book, Precision Agriculture GIS Technologies for Mississippi. The authors thank MSU for data access and the opportunity to recreate one of the precision agriculture tutorials in ArcGIS Pro.

About the Authors
Mike Price is the president of Entrada/San Juan Inc. and was the mining and earth sciences industry manager at Esri between 1997 and 2002. He has been writing tutorials that help ArcUser readers understand and use GIS more intelligently since the magazine’s founding. He is a geologist and has been a volunteer firefighter in Moab, Utah, for many years.

Amelia Fox is an assistant clinical professor in the Precision Agriculture Program at Mississippi State University. She teaches courses on emerging precision agriculture technologies including GIS, remote sensing, small unmanned aerial flight systems, and controlled environment agriculture. She leads a research team aimed at using virtual reality software to train students in high-risk agricultural enterprises. In addition, she works with a team to develop software for applying geospatial technologies to agriculture. She has authored several GIS and remote sensing textbooks on agriculture and developed related curriculum. Fox received her doctorate in agronomy—remote sensing from MSU, her master’s degrees in geography—GIS from Western Illinois University and career and technology education—GIS education from the University of Wisconsin-Stout, and a bachelor’s degree in professional agriculture from Iowa State University.

Creating and Using Layer Files in ArcGIS Pro
For years, ArcMap users have reused symbology and standardized maps with layer files. Layer files preserve the definition queries, symbology, selections, complex labeling, and hyperlinks created for one map so these enhancements can be applied to other maps.

Although layer files are built based on connection to a specific dataset, by importing a layer file to another map and changing the data sources, they may be used to apply properties to other maps if those maps connect to data sources with attribute fields similar to the attribute fields used by the source layer.

In ArcMap, layer files are created by right-clicking a feature class in the table of contents. In ArcGIS Pro, creating layer files uses different processes for individual layer files and group layer files. [Note that layer files saved from ArcGIS Pro cannot be used in ArcMap.]

Saving a Map Layer as a Layer File
1. In the Contents pane, select the layer that is symbolized as you desire and that you will save as a layer file.
2. Click the Share tab, and in the Save As group, click Layer File. Alternatively, right-click the desired layer, and choose Sharing > Save As Layer File from the context menu.
3. In the Save Layer(s) As LYRX File dialog box, type a name for the layer or accept the default name.
4. Optionally, browse to a different folder location. Click Save.

Saving a Group Layer as a Layer File
1. Select the desired group layer, expand and make visible every layer in the group layer that will be the source for the layer file.
2. Click the Analysis tab, then click Tools.
3. In the Geoprocessing pane, type “layer file” in the search box to locate the Save To Layer File tool in Data Management tools.
4. For Input Layer, navigate to the source group layer file and select it.
5. For Output Layer, navigate to the location where you want to store the layer file.
6. Click Run. Click Save.

To test the layer file, create a new project. Add the layer file for the single layer or group layer, and repair any broken data links by linking to the data used for creating the original layer or group layer or to a data source that has a similar field attribute structure.
Have you ever wanted to use a dataset but didn’t know its history, completeness, purpose, or accuracy? If you do not know much about your data, it is difficult to know how reliable and useful your analysis is.

Metadata allows for the effective sharing of data and knowledge across an organization or a larger community of GIS users. It provides a way to document information about your data so that potential users of that data will be able to see if it is suitable for their needs. For this reason, metadata is essential to the effective use of a GIS.

You can document the content and project items you create and use, including maps, projects, geoprocessing models, and geodatabase datasets. In ArcGIS, metadata is saved with the item it describes. Metadata is saved in a geodatabase for geodatabase items, in a project for project items, and in the file system for file-based items. Once created, metadata is copied, moved, and deleted with the item when it’s managed by ArcGIS.

About This Exercise
This exercise will introduce the metadata tools available in ArcGIS Pro. After downloading the sample project, you can follow along and learn how to document data in ArcGIS Pro.

Table 1: Contents pane metadata pages

<table>
<thead>
<tr>
<th>Title</th>
<th>Warren County Mississippi Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tags</td>
<td>Warren County Mississippi, County Boundary, Major Highways, Power Lines, Railroads, Roads, Streams, Towns, Township Boundaries, Waterbodies</td>
</tr>
<tr>
<td>Summary (Purpose)</td>
<td>Warren County, Mississippi, map of base data was compiled as part of a statewide GIS repository effort.</td>
</tr>
<tr>
<td>Description (Abstract)</td>
<td>A map containing vector dataset layers of base data for Warren County, Mississippi. Created using 1990 US Census Bureau TIGER files and periodically updated. The data for countywide files has been clipped using 1:100,000 county borders from USGS Census TIGER files. In 2012, MARIS staff updated line work using 2006 MDEM 2-foot imagery, 2010 1-meter USDA NAIP imagery, MS DOT’s 2009 Official Road Map of Mississippi, and 1-foot BING Pictometry imagery.</td>
</tr>
<tr>
<td>Credits</td>
<td>Mississippi Automated Resource Information System (MARIS) Technical Center</td>
</tr>
</tbody>
</table>

Checking for Metadata
The ExploreMetadata ArcGIS Pro project opens to display a map containing layers of data for Warren County, Mississippi. It would be useful to know more about the history, completeness, purpose, and accuracy.

Note: If you don’t have ArcGIS Pro or an ArcGIS account, you can sign up for a free 21-day ArcGIS trial at esri.com/en-us/arcgis/trial that includes both ArcGIS Pro and ArcGIS Online.
Hands On

of the data from which the layers in the map were derived. Before investigating the data, let’s check if the project contains any information describing the map. On the ribbon, on the Project tab, click Options. In the Options pane for Project options, choose Metadata.

Although ArcGIS Pro uses the Item Description metadata style by default, other metadata styles are available that provide access to more of an item’s metadata content, so you will change the metadata style to the Federal Geographic Data Committee (FGDC) Content Standard for Digital Geospatial Metadata (CSDGM). This is a well-known metadata content standard that has been used in North America and around the world for many years.

1. From the Metadata style drop-down menu, choose FGDC CSDGM Metadata and click OK.
2. Click the Back button to return to the project.
3. In the Catalog pane, expand Maps.
4. In the list of maps, right-click Warren County Mississippi and choose View Metadata.
5. Close the Catalog pane.

The Catalog pane and the Catalog view are similar. You can manage and browse data in both, but they are designed for different tasks. Although both the Catalog pane and Catalog view can be open at the same time, they operate independently. As you generate new items, they are categorized by type and appear on the Project tab in the Catalog pane as well as in the project collection in the Catalog view.

Hint: If you mistakenly close the Catalog view or Catalog pane, you can reopen either from the Windows group on the View tab on the ribbon.

You will use the Catalog view while updating metadata. It displays a details panel with the current metadata for the map. Since you just discovered that the map has no metadata defined, it would be useful to add a summary of the data layers and a description of the symbology and coordinate system used for the map.

Adding Metadata

With the Catalog view open, click the Catalog tab in the ribbon to see the Metadata group. This group contains functionality to edit, import, export, and upgrade metadata.

1. In the Catalog view, click Geography.
2. On the ribbon, click the Preview tab, and use the Pan and Zoom tools to update the display extent to Warren County.
3. In the Preview group, click Create Thumbnail.
4. In the Catalog view, click Metadata to review the updated thumbnail in the Details pane.
5. Next you’ll edit the map metadata. On the ribbon on the Catalog tab, in the Metadata group, click Edit. The Metadata editor pane displays.

Editing Contents Pane

Metadata Pages

Open the Contents pane from the View tab if necessary. Note that it displays available metadata categories that may be updated. These categories include overview, metadata, and resources.

1. In the Metadata editor pane, add the information listed in Table 1.
2. Set the minimum Appropriate Scale Range to 1:500,000 and the maximum...
3. Click New Bounding Box. For Bounding Box, click New Bounding Box and type the coordinates in Table 2.

<table>
<thead>
<tr>
<th>West</th>
<th>East</th>
</tr>
</thead>
<tbody>
<tr>
<td>-91.175758</td>
<td>-90.550942</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>South</th>
<th>North</th>
</tr>
</thead>
<tbody>
<tr>
<td>32.079123</td>
<td>32.619685</td>
</tr>
</tbody>
</table>

Table 2: Bounding box coordinates

Note: When you author or update metadata content for an ArcGIS item, record the information that is important for your organization to know about that item such as how accurate and recent the item is, restrictions on using and sharing it, and important processes in its life cycle like generalizing features.

4. On the Metadata tab on the ribbon, click Apply.
5. On the ribbon, click the Project tab and click Save. By saving the project, all changes made to the project since the last save will be retained, including the edits you made to the Warren County map metadata.
6. Return to the Catalog view to preview your changes.
7. Close the Catalog view. Close the Warren County Mississippi Metadata editor pane.

Exploring Geodatabase Metadata

Now that you have updated the metadata for your project map, you’ll review the metadata for the data sources referenced by the map.

1. If necessary, click the Catalog view to display the ExploreMetadata project items.
2. In the Catalog view, expand Databases, and expand exploremetadata.gdb.
3. Right-click the WarrenCounty_Boundary feature class to see its current metadata and review it. Remember, you changed the metadata style and are currently applying the FGDC CSDGM metadata style.
4. Note the Tags and Description section, which includes the data origin, lineage, and update history. The MARIS Technical Center is the source of this feature class. The center staff appear to have spent considerable time and effort to document this data, thereby making it both useful and searchable.
5. Scroll down the Details pane until you reach the Extent and Scale Range values. These values have been set correctly.
6. Scroll down the Details pane until you reach the Spatial Reference section. The projection is defined as mstm, the state of Mississippi specific spatial reference system developed to store geographic data for the entire state in a single projected system.
7. Scroll down until you reach the Geoprocessing history section. This data source represents a selection made from an original shapefile containing all counties in the state of Mississippi. The fact that the data was originally sourced

Use Table 1 to fill in the Metadata editor pane.
Set the scale range and the bounding box coordinates.
from a shapefile is a good indicator of possible limitations. Shapefiles do not contain an x,y tolerance like geodatabase feature classes and don’t support circular arc curves that use a mathematical formula to draw the curve.

8. Scroll down until you reach the Field section. The fact that the source for this data was a shapefile is a good indicator of potential attribute limitations. The following limitations apply to shapefiles:

- Field names cannot be longer than 10 characters.
- The maximum record length for an attribute is 4,000 bytes.
- Shapefiles do not support BLOB, GUID, global ID, coordinate ID, or raster field types.
- Null values are not supported.
- Date fields only support dates and do not support time.

By reviewing the field descriptions and field types, you can determine if this data source is constrained by the original shapefile properties.

On your own, investigate the metadata for the additional feature classes in explore metadata.gdb. Change the metadata style and review the differences between both the formatting and the level of detail displayed by each style.

The Value of Metadata
When care is taken to provide good descriptive information, you can find items with a search and evaluate which item in your search results is the correct one to use. You can not only improve communication and have confidence in decisions based on an item’s geospatial information, but you can also archive projects, knowing that the data in those projects can be recovered, evaluated, and used in the future. You can learn more by reading the ArcGIS Pro help topic “View and edit metadata.”

Create Your Own Metadata
When you are ready to update and create metadata for your own projects and data, you can streamline the task by creating a metadata template. An organization-wide metadata template can include basic contact and distribution information and legal restrictions that apply to all items. An organizational template can be the basis for project-specific templates that include the purpose for which the project and its items were created, standard place-names describing the geographic region in which the work takes place, and how the project’s deliverables will be distributed and maintained.

The best way to create a metadata template is to fully document an item and save a copy of its metadata as a template. This process creates a stand-alone metadata XML file that doesn’t include unique identifiers or any content that was added automatically to the item’s metadata. Edit the content of the stand-alone metadata XML file to generalize or remove any remaining content that is specific to the original item. Learn more about metadata by reading the ArcGIS Pro topic “Best practices for editing metadata.”

About the Author
Colin Childs is a product engineer for the Learn ArcGIS team at Esri and has been doing GIS for 30 years. Before coming to Esri in 2001, he was an Esri software instructor for the Esri distributor in South Africa. A CompTIA Certified Technical Trainer (CTT+), Childs holds Esri Certified ArcGIS Desktop Professional, Esri Certified Enterprise Geodatabase Management Professional, and Esri Certified Enterprise Geodatabase Management Associate certifications and was an instructor at Esri’s corporate offices in Redlands for 15 years. He holds bachelor’s and honors degrees in geography from the University of Johannesburg.
How to Ensure Your Basemap and Data Layers Work Together

By Diana Lavery

Don’t make the symbology for your data layers compete with your basemap! These tips and tricks will help you make clear, effective, and nice-looking maps by creating high contrast between your basemap and your map’s subject matter.

Choose Your Basemap Wisely
If the topic you are mapping is related to demographics or people, you generally don’t want to use the default Topographic basemap. The colors and the shaded relief texture in that basemap can compete with the colors displaying your map’s subject. The Light Gray Canvas or Dark Gray Canvas or even the Human Geography basemaps (that come in light and dark versions) are more suitable in most cases.

Choosing a good color ramp for the subject you are mapping starts with choosing a good basemap. Feel free to browse through the hundreds of basemaps available from ArcGIS Living Atlas of the World. Choose the one that best fits your needs, or style your own.
High-to-Low Color Ramps
High to low is a style best for mapping a percentage or a rate. This is an easily understood style. The bright colors depict higher percentages. Notice I said “bright” colors—not “dark” colors. When using a dark basemap, you want high contrast to show high values.

The map Where do people live with roommates?, uses a light basemap with a purple high-to-low color ramp. Just as expected, darker purple means a higher percentage of adults living with a roommate.

Another map, Where are households using a Smartphone as their only computing device?, uses the same purple color ramp as in the roommates map, but it’s been reversed because the Nova basemap is dark. Now the lighter color depicts a higher percentage due to its increased contrast with the basemap. The Nova basemap is one of the basemaps available from ArcGIS Living Atlas of the World.

Above-and-Below Color Ramps
The above-and-below style is great when you want to provide an anchoring point. This anchoring point could be a goal, a national average, or some other meaningful value. The two colors—one above and one below the anchoring point—allow anyone viewing your map to immediately see which geographies are above the anchoring point and which ones are below that point while minimizing the impact of extreme outliers on the overall visualization.

Geographies with values close to the anchoring point should be deemphasized. A great way to do this is to give the anchoring value a color that is similar to the color of the basemap. If you’re using a light basemap, the center of your above-and-below color ramp should be light.

The map Is a 40-hour Work Week Normal? map is a great example of this technique. It’s anchored on a meaningful value for this topic, and it quickly conveys that the population in the Midwest works longer hours on average than the population in other places. Counties that have an average of 40 hours are given less prominence as they fade into the basemap compared to the brighter-colored counties.

If you’re using a dark basemap for an above-and-below style of map, the center of your color ramp should be dark. There is some contextual intelligence built into ArcGIS Online called Smart Mapping that will notice you’re using the Dark Gray Canvas.
Hands On

Basemap and will offer above-and-below color ramp suggestions that have a dark center. The effect is that the features that deviate from the center point are the ones most highlighted, as shown beautifully in the map of Opioid Prescription Claims. The map is centered on a meaningful value (in this case, the national average), and the counties that are close to the national average are deemphasized with a color that fades into the basemap.

Heat Map Color Ramps
If you’re working with point data that has lots of coincident points, one option would be to do a heat map. Just as with the above-and-below and high-to-low styles, you want larger quantities to be shown by high contrast between the basemap and the hot spots in your heat map too. If you’re using a light basemap, pick a color ramp that starts with a light color, and vice versa if you are using a dark basemap. By experimenting with color ramps using the Light Gray Canvas and Dark Gray Canvas basemaps, you can determine which is designed to be used with the light basemap and which is designed to work with the dark basemap.

Predominance Map Color Ramps
Predominance mapping is nice when you have a group of different categories with numeric values and lots of features in your map. These categories may have colors associated with them (think red and blue on election maps), or they may not. Sometimes when mapping predominance, one category dominates most of the map. If this is the case, make the most predominant color a subtle color, and let the interesting parts of the map have a more interesting color. In the map How Americans do their Taxes, CPA or Other Tax Professional is the most predominant method at the tract level, so it is symbolized with a subtle color that lets the interesting parts of the map have a more interesting color.

In the map How Americans do their Taxes, CPA or Other Tax Professional is the most predominant method at the tract level, so it is symbolized with a subtle color that lets the interesting parts of the map have a more interesting color.

The Is a 40-hour Work Week Normal? map uses the above-and-below style that highlights the values above and below a meaningful middle value that is used as an anchoring point and is similar to the basemap.

The Opioid Prescription Claims map is centered on a national average. The counties close to the national average are deemphasized with a color that fades into the basemap.

The Is a 40-hour Work Week Normal? map uses the above-and-below style that highlights the values above and below a meaningful middle value that is used as an anchoring point and is similar to the basemap.
Sequential Color Ramps for Ordinal Data

Sometimes, even categorical data has a natural order. Levels of education and age ranges are two common examples of this. ArcGIS Online has sequential color ramps within the predominance mapping style for this very purpose. Just like high-to-low or above-and-below color ramps, you can reverse these sequential-predominance color ramps to make them work well with your basemap.

The What is the Predominant Commute Time? map uses the first two sequential color ramps to map commutes by census tract in Los Angeles County. Tracts in which the most common commute time is the top-coded category length of 60 minutes or more are shown in an interesting peach color.

Choose Your Basemap Carefully

Be careful with filled-polygon maps that use high-to-low ramps on dark basemaps. The connection of dark colors with higher values is deeply entrenched in our minds. The technique of reversing the color ramp against a dark basemap works well for graduated symbols and proportional symbols because the basemap is so visible but if you are making a filled-polygon map, be careful.

A reversed color ramp against a dark basemap can work if the basemap is still visible. However, if you’re zoomed in to a city or town, and not much of the basemap is showing, step back and ask yourself if a dark basemap works or if you should switch to a lighter basemap to avoid confusing your audience. Try dark and light basemaps to see which version portrays your data more effectively.

Make Better Maps

Once you’ve decided on a basemap, the next step is to select a color ramp that will create a high contrast between your basemap and the high values of the subject you are mapping. By keeping this in mind the next time you’re working in ArcGIS Online, you can #MakeBetterMaps.

About the Author

Diana Lavery loves working with data. She has more than a decade of experience as a practitioner of demography, sociology, economics, policy analysis, and GIS—making her a true social science quantoid. Lavery holds a bachelor’s degree in quantitative economics and a master’s degree in applied demography. She has been a product engineer on Esri’s Living Atlas and Policy Maps teams since 2017. She enjoys strong coffee and clean datasets, usually simultaneously.
Smarter Government: How to Govern for Results in the Information Age

By Martin O’Malley

First, as the mayor of Baltimore, Maryland, from 1999 to 2007 and then as a two-term governor of Maryland, Martin O’Malley was known as a leader who demanded accountability and measured results. He introduced data-driven government reporting and management programs such as CitiStat, StateStat, and BayStat.

In his new book from Esri Press, Smarter Government: How to Govern for Results in the Information Age, O’Malley shares stories that illustrate the mind-set and strategies that made his tenure in public office so successful. As he notes in the introduction, “This book is not so much a user’s manual for Stat or GIS but rather a practitioner’s guide for collaborative leadership in the Information Age.”

In the Information Age, O’Malley believes the public’s expectations of openness and transparency in government have increased because the gap between what leaders know and what the people know and when they know it has virtually disappeared. Consequently, maintaining public trust is much more problematic.

To be effective, elected officials must be good at governing and managing and lead with a new emphasis on building collaboration. For this new way of leading to work well, problems must be made visible, solutions adopted, and results measured. This requires innovation in both leadership and technology.

“Now, thanks to new technologies—primarily, [GIS] and the Internet of Things [IoT]—these issues can all be mapped, managed, and measured with greater speed and accuracy than ever before,” said O’Malley. “City services can be delivered with greater openness and transparency than ever before. Our governments can operate with greater efficiency and effectiveness than ever before.”

Beyond the smooth delivery of government services, O’Malley describes a smarter way to achieve public sector progress that also includes preserving and restoring natural resources, such as air, water and land, and protecting the well-being of residents, whose education, health, and safety depend on government. How do government leaders discharge this responsibility? “We do this by setting clear goals, measuring progress, and getting things done,” says O’Malley. Esri, 2019, 332 pp., ISBN: 9781589485242.

Connections and Content: Reflections on Networks and the History of Cartography

By Mark Monmonier

Cartographer and author Mark Monmonier, who is best known for his book How to Lie with Maps, shares his insights about the relationships between networks and maps in this collection of essays. The unifying thread that runs through the book is that behind every great map is a network and behind every great network is a map.

Monmonier is a distinguished professor of geography at Syracuse University’s Maxwell School of Citizenship and Public Affairs and the author of 20 books. He was the editor of Cartography in the Twentieth Century, an encyclopedia published as volume six in the History of Cartography series. His awards include the American Geographical Society’s O. M. Miller Medal (2001), the German Cartographic Society’s Mercator Medal (2009), and induction into URISA’s (Urban and Regional Information Systems Association) GIS Hall of Fame (2016). Esri Press, 2019, 290 pp., ISBN: 9781589485594.
ACDI/VOCA was founded to achieve better lives for people and communities by increasing economic prosperity and social inclusion. It pioneered the value chain approach to international development. [The value chain approach concentrates on the value adding activities required to bring a product or service through the different phases of production.] ACDI/VOCA has worked in 148 developing nations, completing thousands of projects that have fostered broad-based economic growth. The organization focuses its efforts in five primary areas: catalyzing investment, climate-smart agriculture, empowerment and resilience, institutional strengthening, and market systems.

The Feed the Future program in Ghana is one of more than 100 projects ACDI/VOCA is involved in that link farmers, small businesses, rural communities, and vulnerable groups to markets. Feed the Future is the US government’s global hunger and food security program. It supports the Agricultural Development and Value Chain Enhancement Project II (ADVANCE II), which...
is funded by the United States Agency for International Development (USAID). It was originally implemented in Ghana in 2014 by ACDI/VOCA and three consortium partners: Technoserve, ACDEP, and PAB Consult.

Ghana’s Feed the Future’s goal is improving the livelihoods of smallholder farmers in the Republic of Ghana by boosting the productivity of the country’s rice, maize, and soybean value chains. Located in West Africa, Ghana’s agricultural industry accounts for about 20 percent of its gross domestic product and employs more than half of its workforce. The most agriculture production in Ghana is conducted on smallholder farms that average 1.2 hectares of arable land. Primary crops include mango, citrus, cashew, and cocoa as well as rice, maize, and soybeans.

“For ADVANCE II in Ghana, we implemented local agricultural value chains, which refer to all of the farm-to-table processes and services required for growing, processing, managing, and distributing farm products,” said Jennifer Himmelstein, director of corporate analysis and technical assurance for ACDI/VOCA. “Our work involves the examination of the impediments, gaps, and barriers along the value chain and then determining and implementing ways to streamline it to benefit all involved.”

To make the entire process more economically viable, the organization provides agricultural materials and advice to farmers and gives business equipment and specialized training to farm agents, managers, and record keepers.

“We use ArcGIS in a number of ways. For example, we mapped the locations of the various facilities that are included in the value chain, including farms, warehouses, weather stations, tractor service providers, produce aggregators, processors, and so on; as well as developing a demographic profile of those working at the facilities. This allows us to examine trends and patterns in the agricultural value chain,” said Himmelstein.

ACDI/VOCA identifies any bottlenecks at a facility and explores ways that they can be addressed.

\[Map\] showing the relationship between rainfall and the prevalence of Fall Armyworms (FAW), or Spodoptera frugiperda, which causes significant damage to crops in the southern region of Ghana. Data source: Ghana Meteorological Agency, Survey Department ADVANCE II October 2017

Legend

- **Very Severe (2)**
- **Severe (6)**
- **Moderate (7)**
- **Mild (5)**

**ADVSS Rainfall Amt/mm (Jul, 15-21)**

- **5.5-11**
- **12-15**
- **16-20**
- **21-26**
- **27-33**

- **District Boundary**
resolved. For men or women working at a facility, the organization determines if they need access to specific services to help them with this work. Determining who is involved in the local agricultural value chain process, how they are involved, and the benefits that they are receiving from their involvement is important because one of the organization’s overriding goals is the promotion of equality and women’s empowerment.

“The results from our various analyses are available in dashboards for easy visualization, comprehension, and decision-making,” said Himmelstein. “Maps and other strategic data are provided to USAID as part of the required reporting process of the ADVANCE II project.”

It’s commonly assumed that the amount of rainfall is critical to the success or failure of smallholder farmers in any year. Rainfall is particularly important, given the increasingly unpredictable weather patterns throughout the world due to climate change. To examine the correlation between the amount of annual rainfall and its effects on a farmer’s harvest, ACDI/VOCA implemented a study to determine whether its introduction of improved farming methods mitigated the reliance on anticipated rainfall to sustain the harvest.

“The challenge is collecting accurate rainfall data for the areas in which we are working,” said Himmelstein. “There are government weather stations that collect this data, but they are too widely dispersed to provide rainfall measurements to the individual farm level in the areas where we are implementing ADVANCE II practices to increase agricultural yields.”

To deal with these data limitations, ACDI/VOCA uses the IDW tool in the ArcGIS Spatial Analyst toolset to perform inverse distance weighted interpolation on rain data provided by the Ghana Meteorological Agency in vector format. After processing, the resultant raster file allows monthly average rainfall to be determined for study areas. This data showed that the rainfall pattern throughout Ghana has changed over the years. It is not as predictable as it previously was.

Using rainfall as the constant factor, ACDI/VOCA compared agricultural yields from farms implementing ADVANCE II enhanced farming methods with nearby farms not using those methods, ACDI/VOCA concluded that yields for ADVANCE II farmers were greater. ADVANCE II methods, such as using better quality seed, improving water management, and properly applying fertilizers and pesticides, determined the yield for farms—not the amount of rain farms received.

“ACDI/VOCA has been working in Ghana for more than six years on the ADVANCE II project,” said Himmelstein. “By encouraging improved farming methods such as minimum tillage, the farmers are enhancing carbon sequestration in their soil, thus mitigating climate change.”

Another positive effect on ADVANCE II farms was that conservation practices are providing resistance to crop pests and disease, which contributed to increased income and food security throughout the country. So far, ACDI/VOCA has worked with more than 110,000 farmers and others involved in agribusiness in Ghana. The findings from the organization’s work will allow it to scale up its methodology and further expand the agricultural value chain enhancements in Ghana.
In the future, I would like to use GIS to do more predictive modeling to help us develop our intervention strategies more quickly. I also think it could be very useful for analyzing logistics in our development of local agricultural value chains,” concluded Himmelstein.

About the Author
Jim Baumann is a longtime employee at Esri. He has written articles on GIS technology and the computer graphics industry for more than 30 years.
In 2015, Mississippi State University (MSU), developed a focused training program to identify and teach emerging issues in computerized agriculture. The MSU College of Agriculture and Life Sciences (CALS) offers a Precision Agriculture Certificate, a cross-departmental certificate, designed to train students in precision agriculture technologies that complement multiple majors taught across CALS departments.

MSU is in Starkville, an agricultural-commercial-industrial city of nearly 24,000 located in northeastern Mississippi. Founded as the Agricultural and Mechanical College of the State of Mississippi in 1878, it became Mississippi State College in 1932. It was fully accredited as a university in 1958 and has evolved into a comprehensive, doctoral degree-granting institution with a nationally and internationally diverse student body.
University researchers and instructional faculty are assisted by an effective research administration that has placed MSU among the top 100 universities in the nation in research and development in the sciences and engineering. The Mississippi Agricultural and Forestry Experiment Station operates 16 branch stations throughout the state and conducts research in a variety of areas as well as assists in the university’s teaching and service functions. The MSU Extension Service offers programs and services to state residents through campus and county offices and personnel.

GIS is taught in several different departments at MSU including Geosciences, Forestry and Wildlife, Landscape Architecture, Agriculture Bioengineering, and Plant and Soil Sciences. The MSU Precision Agriculture Program was developed from private foundation donations to establish an interdisciplinary faculty team addressing emerging issues in computer-based agriculture. Its curriculum is supported by generous gifts from Monsanto and the Dianne Hawks Precision Agriculture Curriculum Endowment. The Monsanto Company also funds scholarships that help students study precision agriculture.

Dr. T. J. Bradford teaches the precision agriculture GIS coursework for the program. Dr. Amelia Fox, an assistant clinical professor in the Mississippi State University Precision Agriculture Program, who originally developed the geospatial laboratory and curriculum, trains students in a broad array of emerging precision agriculture technologies including GIS, remote sensing, small unmanned aerial flight systems, and controlled environment agriculture. In addition to authoring several GIS and remote sensing textbooks on agriculture for MSU, Fox leads a research team developing a program that uses virtual reality software for training students in high-risk agricultural enterprises.

GIS provides critical program support for field data collection, data management, mapping, modeling, and fiscal analysis. To introduce students to GIS in precision agriculture, Fox developed an ArcGIS Desktop training program that includes seven exercises that guide students from introductory GIS concepts through preparation of a multidisciplinary project reference map to mapping, modeling, and analyzing field performance, crop yield, and finances.

These exercises were written and compiled into a textbook, *Precision Agriculture GIS Technologies for Mississippi*, First Edition. The book contains chapters on file management, data management, navigation, and telemetry. Copyrighted in 2019, Fox licensed the book under a Creative Commons Attribution-NonCommercial license to reach a larger audience and support similar programs with materials. It is available as a PDF for free download and unlimited educational use from https://ir.library.msstate.edu/handle/11668/14835. A chapter from this book inspired the tutorial “Making a Precision Reference Map in ArcGIS Pro” that Fox coauthored with Mike Price, which is in this issue of *ArcUser*.

New MOOC Focuses on Spatial Data Science

In 2020, Esri will add Spatial Data Science: The New Frontier in Analytics to its popular collection of massive open online courses (MOOCs). Data scientists, GIS analysts, and others with a strong background in statistics and analytics are the target audience for this free, six-week course.

Recognizing users’ strong interest in the emerging field of spatial data science, the course demonstrates how incorporating spatial data, tools, and methods enhances analytical and predictive models through hands-on exercises, performing suitability analysis, predictive modeling, time-space pattern mining, and object detection.

Like data science, spatial data science employs methodologies and tools to extract nonobvious and useful patterns from data, enabling practitioners to make predictions. However, by incorporating geographic data and spatial analysis methods, spatial data science adds place-based context and greater insight to the practice of data science.

Using a comprehensive set of analytical methods and spatial algorithms, including machine learning and deep learning techniques, students will work through realistic scenarios and develop iterative analysis workflows, train and optimize models, build compelling information products, and share results.

Coursework includes not only hands-on software exercises but also videos featuring Esri experts, quizzes, and interactive discussions that encourage learners to problem-solve together. Not only are Esri MOOCs free, but they also include access to ArcGIS software for the duration of the course. Attendees should plan to spend three to four hours per week on the course. Esri will award a certificate of completion to everyone who finishes the course.

To be added to the waiting list for Spatial Data Science: The New Frontier in Analytics, visit https://bit.ly/2nj4kJh. To receive updates about the course and spatial data science news, join the Spatial Data Science: The New Frontier in Analytics group on LinkedIn at pctx.ly/r/910i.
At the university level, formal GIS training is often aimed at students who are focused on geographic or environmental studies. Yet interest in spatial thinking is growing in history, language arts, and other humanities, which have not traditionally used GIS.

The best tool for engaging these non-technical users is the Esri Story Maps app, as it provides an approachable and effective introduction to the importance of place. In addition, instructors are drawn to the platform’s narrative qualities and the ability to weave together text, maps, and other media to make content come alive in a shareable digital form.

A team of academic technologists and faculty at the University of Minnesota has sought to implement story maps in courses across the College of Liberal Arts (CLA) and beyond. Since instructors and students in these courses tend to be unfamiliar with digital approaches or have limited time for technical training, traditional GIS training methods simply don’t work for this population.

With the help of an Academic Innovation Grant from CLA, the StoryMaps Curriculum Team has partnered with instructors to design story map-based assignments that quickly teach basic technical skills, demonstrate the spatial power of GIS, and have students walk away with finished digital products. In addition to designing assignments and running in-class workshops, the team designed an ArcGIS Hub site, which contains resources to support instructors and students who undertake story map assignments.

Case Studies from Courses
To begin its initiative, the team conducted one-on-one consultations with instructors who wanted their students to build story maps for some assignments. The challenge was that there is no single way to conduct story map assignments, as each class dealt with a unique topic, required diverse kinds of data, and had very different learning goals.

One course the team worked with was an upper-level history class on early Latin America taught by professor Sarah Chambers, who had the four honors students enrolled in the course. These students completed three story map assignments:

- **The Richest Mountain: Potosi and the Silver Trade**
  - This story map was created by students during an in-class group exercise on the early modern Spanish silver trade for a course on Latin American history.
assignments to replace written ones. In the most fascinating story map assignment, students created a short story map in only a week as part of an in-class group exercise on the early modern Spanish silver trade. Each student covered a specific aspect of the topic and was assigned a corresponding reading from a course text. From these texts and some additional research, each student identified locations that pertained to their topic and created an ArcGIS Online web map using map notes to sketch relevant points and other features. They wrote short descriptions of their topics and the relevant locations that would serve as text for the story map. In class, students combined the prepared web maps and texts into an Esri Story Maps Journal app and discussed how mapping these locations changed their perspective on each topic.

This project was a huge success. Not only did students create a compelling collaborative story map in a single week, they also made fascinating spatial observations in the process. During discussion, one student noted that visualizing the movement of silver made them question their textbook, as the route of the silver supply described by the author did not seem to account for the natural physical barriers, such as mountains and deserts. This demonstrated how visualizing material through basic web mapping has the power to transform one’s historical perspective with a critical spatial lens.

Professor Ann Waltner, another history faculty member who has adopted story maps, built an assignment with the team for her upper-level history methods course. This class used early 20th-century Shanghai as the theme through which to explore different approaches to history, including digital and spatial ones. For their final project, which took place over roughly six weeks, groups of students created story maps focused on different aspects of the city, such as its nightlife, public spaces, and crime.

This assignment was largely exploratory, as the instructor had students map the locations of people, places, and events drawn from original primary sources without knowing exactly what students might find. Through a series of in-class workshops, students learned how to geocode spreadsheet data to turn qualitative textual information into mappable data points. Pinning down locations was no easy task, but they utilized georeferenced historical maps to overcome the confusion caused by changes in the landscape, street names, and address numbering system of Shanghai over the last century. With web maps built, students then created story maps displaying their findings.

The projects that resulted from the assignment varied widely, but one story map stood out. This project focused on the relationship between Shanghai’s police stations, dance halls, and prostitution activity. The students worked with police records from the 1930s and 1940s, pouring over descriptions of police incidents and painstakingly located where they occurred. Often, they had little to go beyond vague references to surrounding landmarks. The process of turning these records into spatial data highlighted the immense challenge of visualizing historical locations and events. The value of this assignment came not only from the story maps produced but also in how the mapping process made students think differently about history.

The team also built assignments for an interdisciplinary course on the electric grid system that was co-taught by Jonee Brigham from the Minnesota Design Center and Paul Imbertson, a professor of electrical engineering. Students created story maps as public education projects, which they shared online and presented in a pop-up exhibit at the Bell Museum of Natural History.

This highly structured semester-long group assignment took place in two phases. In the first phase, students created Power History, an Esri Story Maps Journal app about an issue concerning the electric grid in the recent or distant past. This part of the assignment was largely a trial run that gave students an opportunity to learn the ins and outs of story maps and ArcGIS Online. In-class workshops taught them how to geocode spreadsheet data, search for existing data in ArcGIS Living Atlas of the World, and pull multimedia into a story map.
map to create a collaborative digital communication piece.

After this first story map project, students started on their Power Futures projects. These were public education pieces that addressed a present issue facing the electric grid and how to tackle it. Throughout this process, students had frequent in-class group work time, submitted multiple drafts, and received feedback on presentations.

The assignment resulted in well-polished story maps on topics ranging from energy storage to eco-homes. [Eco-homes are designed to be environmentally low impact and have a smaller carbon footprint and lower energy requirements.] Though each project included at least one web map, students tended to de-emphasize spatial elements in favor of text, images, and videos that highlighted story maps as a digital communication platform.

However, a few groups made greater use of mapping. One project addressed the dangers wind turbines pose to bats and other wildlife. With the help of the team, students pulled data on reported bat sightings from iNaturalist. [iNaturalist is an online social network that shares biodiversity information.] Those sightings were linked with a layer depicting wind power installations that had been created by filtering Power Plants in the US, a layer of Energy Information Administration data available from ArcGIS Online. Students created an engaging map. They observed that people tended not to report bat sightings near wind power sites, despite the real threat turbines pose to bat populations.

In addition, the audience at the museum pop-up exhibit was most responsive to projects that had strong spatial elements, like this one. Interactive web maps caught museum goers’ attention more than other multimedia and could communicate information more quickly than by reading the accompanying text. This project showed that—while story maps can be effective for public engagement without maps—they are most successful when students take full advantage of the spatial tools at their disposal.

These case studies are representative of the excellent student work that resulted from the team’s initiative. Each assignment differed in its duration, spatial elements used, and goal and produced many different story maps. Yet across all topics and disciplines, the program gave students the chance to engage with a new spatial mode of critical thinking.

Empowering Future Courses

The team’s time in the classroom showed what is necessary to make story map assignments work for any discipline. During this process, the team created a series of resources for instructors and students, which they compiled into an ArcGIS Hub site (storymaps.umn.edu). The site is divided into three sections: a gallery of student work, instructor resources, and student resources.

→ Reducing Bat Deaths from Wind Power is a story map that resulted from a project that addressed the dangers wind turbines pose to bats and other wildlife.
The instructor resources section assists with every step of teaching with story maps from assignment design to quick how-to tutorials during the story map building process and reviews these resources and how they help make story maps work for instructors and students alike. In addition to materials for designing and implementing a story map assignment, a series of prompt templates and instructor guides are available, sorted by assignment duration and whether they are group or individual assignments.

These templates are based directly on the prompts designed for the courses the team worked with and contain guidance on the framing, scaffolding, grading, and more essential steps for these assignments. This page also provides resources for finding data, sample grading rubrics, and even a set of sample presentations and story maps to be shown in class. These resources are intended to make instructors who are new to GIS as independent as possible when running a story map assignment.

The student resources page provides guidance for students working on projects. It includes material on building ArcGIS Online web maps and creating story maps applications. The page includes links to step-by-step guidelines and best practice references for web maps and story maps.

The team also created a series of short how-to videos focused on tasks that students may need to complete. Whereas many GIS help resources provide extensive detailed guides for each step, these two- to five-minute videos are easily understood by students who are intimidated by the intricacies of GIS.

The gallery of student work, drawn from different courses at the University of Minnesota, complements the instructor and student resource pages. It shows students what a successful story map looks like and shows instructors the type of work students can produce. The story maps discussed previously can be found in the gallery, along with other excellent work.

The team’s initiative is ongoing, and it continues to expand the hub site and reach courses in other disciplines. With the release of ArcGIS StoryMaps, the team will adapt its materials and explore the new opportunities it presents for student work. Story maps are proving to be an excellent platform for instructors to teach both dynamic digital writing and transformative spatial perspectives. With the right guidance, story maps have the power to introduce students to the world of spatial thinking and change how they perceive the role of place in their studies.

For more information, contact University of Minnesota’s U-Spatial mapping center at uspatial@umn.edu.

About the Author
Christopher Saladin is an ancient history PhD student at the University of Minnesota. He works as the Story Maps Curriculum Fellow for the U-Spatial mapping center, helping develop resources for teaching with story maps in humanities classrooms.
He Pays Attention to the Little Things That Run the World

By Carla Wheeler

A quarter of a century after first addressing the Esri User Conference, entomologist Edward O. Wilson returned to the plenary stage in 2019 to promote the Half-Earth Project, a conservation effort supported by Esri. [Read the accompanying article “The Half-Earthling to learn more about this project.]

In nearly a century of living and studying living things, Wilson has undoubtedly seen more ants than the busiest professional bug exterminator. Placing the words ants and exterminator together in a sentence in an article about Wilson could strike a nerve among people with an affinity for ants. As a man who has studied ants for most of his life, it’s not surprising that one of the most common questions Wilson gets asked by people is what to do about the ants that crawl into their houses. Spray? No way!

“They are missing some of the wonders of nature,” Wilson insisted. “I love having a colony of ants in my kitchen. What I do is I give them something to eat [like] cookie crumbs.”

Once, a colony took up residence near Wilson’s kitchen sink. “They would come out of a crack in the base of the edge of the sink. Instead of spraying them or squishing them, I would put food out for them and watch,” he said. “The scout would come out and smell and then he would get all excited. It would go running back, laying a little trail and, in a few minutes, out would come a whole bunch of ants out along the trail. I enjoyed having a pet colony. I recommend it.”

As a teenager, Wilson reported the first known colony of imported red fire ants in his home state of Alabama. Later, he studied the warrior-like Matabele ants in Africa, the critically endangered Aneuretus simoni in Sri Lanka, and thousands of other species. Several of his 32 books focus on the ant world, including The Ants [coauthored with Bert Hölldobler], which won a Pulitzer Prize, and his only work of fiction, Anthill: A Novel.

In the late 1950s, Wilson made what he considers his single most important discovery: pinpointing which gland in ants gives them the ability to communicate with each other.

“When I made it, I couldn’t sleep that night—that kind of a discovery,” Wilson recalled. “I knew that ants communicate, not by touch—there isn’t any signaling something—not by any sound—but by chemicals—pheromones, that is, odors that they would release, substances they would spread from a gland that would give a message to other ants. That was only vaguely thought when I decided to check this all out and see if I could break the pheromone code.”

Using fire ants for his experiment, Wilson tested different glands with no luck until he extracted the Dufour’s gland at the base of the sting.

“I had noticed when the fire ants find food and return home they stuck out their sting and were dragging their sting,” he said. “[Dufour’s] was a little teensy gland that took really a lot of effort to dissect out. But when I took it out and made an artificial trail with it, I could lead fire ants anywhere I wanted.”

It was an amazing sight to the young entomologist. “The fire ant would discover food, come running back, laying a trail, rush into the nest, and then rush up to other fire ants—almost like grabbing them by the shoulder and shaking them and saying “Food, food, I found food! The ants smell the trail and get on the trail, and they run back.”
Right now, Wilson’s research focus is on ecosystems. Little research has been done on them. But their importance is inescapable.

Much more data on plant and animal species needs to be collected, both by scientists and citizen scientist volunteers, according to Wilson. He recently celebrated his 90th birthday by participating with taxonomic specialists, students, families, and other community members in the Great Walden BioBlitz at Walden Woods in Massachusetts. Wilson made a special point of spending time with a group of children collecting samples of organisms, including ants.

Wilson likes to use the example of the ecosystem of the sea otter, which was hunted to near extinction on the Pacific Coast by the early 1900s. When the sea otter population fell, the kelp forests along the coast disappeared too. That threw an entire ecosystem off kilter.

“The kelp forest of seaweed and algae along the coast declined and, in places, disappeared,” Wilson said. “What had happened? The sea otter fed upon sea urchins that live in kelp forests. The sea otter was the urchins’ main predator. The sea urchins exploded in population. They did not have their predator that kept them in control. There were so many of them that they ate the kelp. When sea otters were allowed to come back—hunting was forbidden—then the sea otters reduced the numbers of sea urchins, and now the kelp is coming back.”

Wilson said not much is known about ecosystems, but he hopes to change that. “What I am doing right now is to begin systematic studies, deep studies, mathematical studies of ecosystems,” he said. “It’s so complex; nobody understands them.”

He wants to find out how ecosystems are formed, how they evolve, and then how they equilibrate. “A pine forest has been there for a thousand years. How did [the trees] come to a point where they don’t change much?” he asked.

It’s a tall order, but Wilson is never one to slow down. “I’m 90 now, so I’ve got to get this done before I pass on to that great rain forest in the sky,” he said with a smile.
EDWARD O. WILSON—world authority on ants, honorary curator in entomology, and university research professor emeritus at Harvard University—attended the 2019 Esri User Conference (Esri UC) in San Diego, California, to speak about something that is just as near and dear to him as insects are: protecting biodiversity around the world.

The Half-Earth Project, an initiative of the nonprofit E.O. Wilson Biodiversity Foundation, advocates conserving half the earth’s lands and seas to protect 85 percent or more of the planet’s biodiversity and reverse the current species extinction crisis (that includes ants, of course). According to Wilson, there may be as many as 10 million species of plants and animals in the world, but only about 2 million have been discovered by science.

“I want us to create a system of natural reserves or specially managed areas large enough to save—indefinitely, in natural conditions—a very large percentage of the species on earth,” Wilson said onstage at the Esri UC Plenary Session.

Wilson authored *Half-Earth: Our Planet’s Fight for Life*, from which the Half-Earth Project was born. He is 100 percent in on the Half-Earth Project because of what he described as the three great environmental crises that loom: climate change, a shortage of freshwater, and a collapse of ecosystems due to a mass extinction of species.

“The sooner we face [these issues] squarely and honestly, the more likely we will be able to solve them at minimal cost,” he said. During the Esri UC Plenary Session, Wilson joined Esri president Jack Dangermond and Jane Goodall, DBE, founder of the Jane Goodall Institute, for a wide-ranging discussion titled “The Importance of Biodiversity Conservation at a Global Scale.”

Wilson said that he and a colleague, Robert MacArthur—an ecologist and mathematician at Princeton University—developed the formula for the Half-Earth calculations.

“If we can set aside half of the earth’s surface, and especially if it includes the beautiful natural areas that we’ve held onto, then we can save a very large percentage of all the species on earth indefinitely,” said Wilson. “This brings with it a chord of hope. I’m happy to tell you that the Half-Earth proposal has become an initiative, and I think it has been pretty well accepted by conservation organizations and activists around the world.”

THE IMPORTANCE OF BIODIVERSITY

Wilson defines biodiversity as “the totality of inherited variation among species” that exists in three levels of biological organizations: ecosystems, species, and genes.

“An ecosystem is just a conglomerate of interacting species that are depending, to some extent, upon [each other’s] survival and reproduction,” he said. “A species is a population or a series of populations of organisms that freely interbreed with one another or are capable [of doing so]. Genes prescribe the traits of the species that form the ecosystems.”

Esri is partnering with the E.O. Wilson Biodiversity Foundation to identify and map the world’s known species at a highly detailed

By Carla Wheeler

THE HALF-EARTH(LING)

During the 2019 Esri User Conference Plenary Session, Edward O. Wilson joined Esri president Jack Dangermond and Jane Goodall, DBE, for a wide-ranging discussion on biodiversity.
level. That information can then be used to help prioritize areas for conservation.

Esri’s contributions will include technical expertise, ArcGIS technology, and financial support. The Half-Earth Project, in collaboration with Esri, plans to develop a global map of species distributions at 1-kilometer resolution within the next five years.

With most species yet to be discovered, Wilson said he would like to see science focus more on the tiniest organisms among us such as oribatid mites, springtails, and nematodes.

“Pay attention to what I call the little things that run the world,” Wilson said. “Being big mammals, we are focused on the creatures most like ourselves. At the same time, we are going to have to develop a lot of science that reaches down into the smaller organisms . . . to the millions of species of insects, of creatures most people have never heard of, that are nonetheless fundamental in maintaining these ecosystems, [ranging from] the cornfields to the cacao plantations.”

INSPIRED MAPPING AND ANALYSIS
Analyzing and mapping information collected on plants and animals are essential to the success of the Half-Earth Project, from setting conservation priorities to developing a better understanding of organisms and how they operate within ecosystems, according to Wilson.

“This entails a tremendous amount of inspired mapping and analysis—not only where the biodiversity is, because this is crucial for saving it as a whole, but also where the species are and in what places they create ecosystems of a certain kind, which we can study and figure out how it all works,” he said.

The Half-Earth Project has launched the Half-Earth Map, which leverages geographic content from Esri’s ArcGIS Living Atlas of the World. Upon opening the app, people can select from a list of species (e.g., amphibians, birds, cacti, conifers, mammals, hummingbirds, and turtles) and see, on a map of the world, where these groups are abundant and where they are rare.

“You have got to know all the different organisms and where they are found,” Wilson said during an interview that followed his talk. “There will be places where there will be, for one reason or another, little biodiversity. But then there will be places where it’s extremely rich. If you use the Half-Earth plan, what you want to do is make sure as many of the species-rich areas [as possible] are in the half that is preserved.”

For more information about the Half-Earth Project, visit half-earthproject.org.

Learn more about how Esri is supporting the Half-Earth Project at https://bit.ly/2Mia0oM.

Watch Wilson’s discussion of biodiversity with Jane Goodall and Jack Dangermond at the Esri UC at https://bit.ly/2Ts9x4g.

The Half-Earth Project, an initiative of the nonprofit E.O. Wilson Biodiversity Foundation, advocates conserving half the earth’s lands and seas to protect 85 percent or more of the planet’s biodiversity and reverse the current species extinction crisis.
HARNESS THE POWER OF WHERE

Earn a Master of Science in GIS or Master of GIS in an environment where international faculty and students use cutting-edge GIS technology, theory, and applications.

Use the power of location intelligence to improve decision-making and organizational performance, equipped with a Redlands MBA with a concentration in location analytics.

Undergraduate students can declare a spatial studies minor to develop GIS and spatial thinking skills in class and through internships and community service.

All Redlands academic programs enable access to Esri technology, training, people, events, and internships, including classes taught by Esri employees.

The University of Redlands is a private, nonprofit university located in Redlands, California—close neighbors and partners with geospatial leader, Esri.

spatial.redlands.edu
SEE HOW TO DESIGN TOMORROW’S SMARTEST CITIES, TODAY.

By 2050, two-thirds of the world’s population will live in cities. Today, Esri location technology is helping governments and urban developers better utilize limited space to grow smarter, better, and even greener.

If Esri can help the world’s leading urban developers see how to run and future-proof their cities, what could you see?

See what’s possible at esri.com